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Disclaimer  

By using this software, the user accepts complete responsibility for each and every aspect of
safety associated with the use of the Laser machine, Laser system and Lightburn Software. You
agree that:

1. You will not hold the author or contributors of LightBurn liable for any damage to
equipment or persons from the use of LightBurn.

2. You know the potential hazards in using high power lasers and high voltages.
3. You will wear professional laser-eye-protection when using a laser controlled by LightBurn
4. You will use the LightBurn software in a legal and safe manner.
5. You relieve the author and contributors from any liability arising from the use or distribution

of the LightBurn software.
6. You are entirely operating at your own risk. Lasers can be lethally dangerous.
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Requirements  

Minimum Computer System Requirements  

LightBurn will run on Windows 7.0 or later, 32 or 64 bit, MacOS 10.11 or later, or 64 bit Linux.
LightBurn does not require a powerful computer for most work, though if your designs contain a
lot of images, more memory is helpful.

 

LightBurn talks to many different kinds of lasers. If you aren't sure what yours is, this guide may
help: https://lasergods.com/controller-dsp-identification/

 

Supported Laser Hardware Controllers  

Ruida RDC644xG/S, RDC6334, LightObject R5-DSP, RDLC320A, RDLC220, and numerous
others
Trocen AWC 608 and 708c (Ethernet connections only)
Smoothieboard (including Cohesion3D Mini and Remix)
GRBL 1.1 and GRBL-LPC (Including Gerbil, X-Controller, ManaSE, and others)
Marlin 1.1.9 or later

New controllers added regularly, if your controller is not listed, please contact the developers at li
ghtburnsoftware@gmail.com
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LightBurn  
Better software for laser cutters  

 

Created by LightBurn Software, LLC

Homepage: http://LightBurnSoftware.com

Contact: support@lightburnsoftware.com
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Copyrights  
LightBurn - Copyright (c) 2018, LightBurn Software, LLC

PoTrace - Potrace image trace library licensed from IcosaSoft Software

 

OpenCV

Intel License Agreement For Open Source Computer Vision Library

Copyright (C) 2000, Intel Corporation, all rights reserved. Third party copyrights are property of
their respective owners.

Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

Redistribution's of source code must retain the above copyright notice, this list of conditions
and the following disclaimer.
Redistribution's in binary form must reproduce the above copyright notice, this list of
conditions and the following disclaimer in the documentation and/or other materials
provided with the distribution.
The name of Intel Corporation may not be used to endorse or promote products derived
from this software without specific prior written permission.

This software is provided by the copyright holders and contributors "as is" and any express or
implied warranties, including, but not limited to, the implied warranties of merchantability and
fitness for a particular purpose are disclaimed. In no event shall the Intel Corporation or
contributors be liable for any direct, indirect, incidental, special, exemplary, or consequential
damages (including, but not limited to, procurement of substitute goods or services; loss of use,
data, or profits; or business interruption) however caused and on any theory of liability, whether
in contract, strict liability, or tort (including negligence or otherwise) arising in any way out of the
use of this software, even if advised of the possibility of such damage.
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Installation  

Download  

Download the latest release version that matches your computer.

Windows 64-bit
Windows 32-bit
Mac OSX
Linux 64-bit

Windows Installation  

1. Launch the installer executable
2. Windows may ask if you trust the software, as LightBurn is not currently digitally signed
3. Select if you would like to create a desktop icon
4. Click Install
5. Click Finish

That's it! Locate the LightBurn icon to launch the program

 

Mac/OSX Installation  
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1. Download the Mac/OSX version
2. Double-click the .zip file to extract the DMG (disk-image) file
3. Double-click the LightBurn.dmg file to mount it
4. Drag the LightBurn application into your applications folder
5. Launch LightBurn from the launcher as normal
6. You can now eject the DMG file (drag it to the trash bin)

Linux Installation  

1. Open a terminal and run the following command:

sudo adduser $USER dialout && sudo adduser $USER tty

2. IMPORTANT! Log out and log back in (this refreshes the permissions we just added)

3. Download the Linux 64-bit version, either the .run  file or the .7z  file and follow the
appropriate steps below:

.run  installer  

4. Open your terminal and cd  to the directory you downloaded the file to.
5. Run bash ./LightBurn-Linux64-v*.run

6. It will not automatically install and great a program listing in your desktop environment.

.7z  installer  

4. Extract the folder wherever you want Lightburn to exist
5. Right click AppRun  > Properties > Permissions > 'Allow executing file as program'
6. Double click AppRun  inside your Lightburn folder
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Licensing  
There is a 30 day free trial with no restrictions on the software. The trial version will work with all
supported hardware.

Once the trial expires, you will need to purchase a version for your hardware: The standard
version for GCode based machines, or the Pro version for Ruida DSP controllers. The pro version
will include additional hardware DSPs as those come online, and will include the Gcode back ends
as well, however that is currently the only difference.

Entering your License Key  

Pricing  

GRBL or Smoothie: $40 one-time purchase fee  

Ruida or other DSP: $80 one-time purchase fee  

Both include all published updates and bug fixes for a year. After that first year, the software will
keep working as is, but won't be eligible for further updates. If you want additional updates
beyond the first year, a small (probably $20) renewal fee will get you another year. Regardless of
whether you decide to update or not, the version you have will keep working forever.

You can install the product on up to two machines at a time, so people with Mac/PC setups, or a
PC in the house and one in the shop will be covered. Licenses can be transferred between
machines if you get a new PC.

Note: As of version 0.8.00 the licensing system was redone. If you are upgrading from v0.7.x
to 0.8.x or greater and have difficulty with your license, please contact Lightburn Software
for assistance.

Contact LightBurn Software to discuss multi-seat or institutional pricing.
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Settings  
This is the main LightBurn settings page.

 

There are a few different sections here, all related to different settings:

Display / Graphics
Units / Grid
DXF Import Settings
Shape Move Increments
Output Settings
Other Setttings

Display / Graphics  

These settings affect only the visual display quality of LightBurn - changing these does not affect
the generated output to your machine.

Curve Quality  

This controls the level of precision that LightBurn outputs splines. If you look closely at the
comparison below, you can see the right image is made of straight lines, about 1/8" (4mm) long.
The left image is also made of line segments, just many more of them, so the effect is
imperceptible. This extra quality comes with a slight cost in speed. You'll only likely notice it in
files with thousands of curved shapes.
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Anti-aliasing  

Aliasing is commonly called "jaggies" - in our case, it's the visible appearance of pixels when
drawing 2d shapes. Anti-aliasing draws shaded pixels on either side of the drawn lines to give the
appearance of higher resolution and a smoother result. The image below compares the two - The
difference is very apparent, however this comes with a moderate performance penalty. If you are
running an older machine, turning off antialiasing may improve the interactivity of LightBurn on
dense scenes.

Invert mouse wheel zoom direction  

I'm a PC guy, with a Mac, and the scroll wheel always feels backwards to me, so this switch
changes the direction you scroll when zooming. If you're a Mac person stuck on a PC, this is also
for you.

Use System Clipboard  

Enabling this makes copy and paste operations slightly slower, but allows LightBurn to:

Copy and paste across different runs of LightBurn, or between two running copies of the
app
Paste images copied from other software or web browsers
Paste text directly into the edit window, auto-creating a text object for you

Units & Grid  

Inches / mm  

LightBurn internally operates in millimeters, but can display in either millimeters or inches.
Speeds can be represented as either units per second or units per minute. Users with diode
lasers will likely prefer the units per minute setting, whereas CO2 lasers generally express speeds
using units per second.

Visual Grid Spacing  

The visual grid is set to 10mm by default. Note that this is independent of the Grid Snap setting
below.
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Grid Snap Distance  

Positioning of lines and other primitives will snap to the Grid Snap distance unless overridden
using the Ctrl key. The default for this is 1mm.

Click Selection Tolerance  

This is how close you have to be to a line or vertex, in screen pixels, to click it. Increase this
number if you have trouble selecting things, decrease it if you find yourself selecting things you
didn't mean to.

Object Snap Distance  

Controls how close, in screen pixels, your cursor has to be to an object vertex or center to engage
the object snapping behavior.

Snap to Objects / Snap to Grid  

LightBurn has two snapping behaviors which can be enabled / disabled here. Snap to Objects will
snap your pointer location to the nearest object center or vertex when creating new objects, or
drawing lines, making it easier to connect and align shapes. Snap to Grid will snap your cursor
position to the nearest grid location, as specified by the Grid Snap value. Note that the Grid Snap
and the Visual Grid do not have to be the same.

 DXF Import Settings  

Units  

DXF files do not store the measurement system that was used to create them. If you create an
object that is 5 inches wide, it might import as 5mm wide, because LightBurn can only see the '5'.
Similarly, if your object was created in microns, it might import huge. Set this value as
appropriate before importing DXF files to ensure correct scaling.

Auto Close Tolerance  

DXF files are often saved as a collection of discrete pieces, instead of continuous paths. The Auto-
Close Tolerance value tells LightBurn to connect any lines or curves that are on the same layer
and closer together than this value.

Shape Move Increments  

When moving objects with the cursor keys in the edit window, these values control the distance
to move the selection, when using the arrow keys by themselves or with the Control or Shift
modifiers.

Output Settings  

These two settings affect the output sent to the laser.

Job Origin  

This setting controls where LightBurn assumes your laser position to be relative to the graphics in
your project when using a "Start From" value of "Current Position" or "User Origin". This is
explained in more detail in the Coordinates and Origin settings page.

Curve Tolerance  
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This setting is similar to the Curve Quality setting above, except that it controls the quality of
output to the laser. The number is a measure of how much error to allow in the output. A value
of 0 would be "perfect", but would create very dense data, as some lasers can only process line
segments.

In the above image, the blue curve between the two points is the ideal shape. The black line is a
straight line between them, and the red line shows the error (how far the line is from the curve).
LightBurn measures this error, and if it's equal to or lower than the Curve Tolerance value, it
outputs the straight line. If not, the curve is subdivided into two linear segments and the process
repeats with each new segment. Those segments are shown below in violet, along with their new
error values. You can see that the two new lines do a much better job of approximating the
original curve.

Most people will probably never need to change this - the default is 0.05mm, which is about 1/2
the width of a typical beam. Note that this is the maximum error value allowed, so typical output
will be better than this, and this only affects curves, not straight lines or vertices, which are exact.

Other Settings  

Auto Save Interval  

You can set the frequency of your auto-save by adjusting the value in minutes here.
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Device Setup  
If you've never run LightBurn, the first thing you need to do is set up your machine layout (work
area size and zero / origin) in the settings, and then add your device type in the devices box. If
you have more than one type of laser / device, you can add more than one and choose a default.
At present, the layout and page size aren't associated with the device, but this will be changed to
that in the future.

Adding a new device (Laser)  

If you've never used LightBurn before, you'll need to tell it a couple things about your hardware
to get going.

1. In the lower-right of the display is a box called "Laser" - on the bottom of it is a button called
"Devices". Click it.

2. Click the New Device button (highlighted in red, below):
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3. Choose a device that matches the one in your laser. Don't worry if you have more than one
laser. Start with one for now, and add the others later.

4. Choose your connection method. Serial/USB, Network, etc...



5. Choose a distinct name and set your machine bed size for X and Y

6. Choose the 0,0 origin point that matches your machine



7. Click Finish to save your laser setup

If your laser is connected to the computer, LightBurn will try to establish communication. For
some systems this will home the laser, for others it will simply show "Ready" in the status box at
the top of the laser tab, or the bottom status bar, depending on your system.

If you are adding multiple devices, repeat the steps above for each machine. When you are done,
you can set the default connection by clicking on the name in the device list and clicking the Make
Default button.

You may also edit or remove devices by clicking the device and choosing the appropriate button.
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Device Settings  
After initial setup, you can access device settings under the Edit > Device Settings menu.

 

Working Size  

This is the working size of your laser bed. Set this to the maximum X and Y travel for your laser.

Origin  

This is the origin or 0,0 location for your laser. If you have a GCode based system, this is almost
always at the front left, regardless of the location of your limit switches. If you have a DSP laser,
like Ruida or Trocen, the origin is usually where the limit switches are placed.

Scanning Offset Adjust  

Scanning offset is useful when doing raster or vector scanning at high enough speeds that delays
in your power supply cause the firing point to be a little behind where it should be. See the help
for Scanning Offset Adjustment here.

Fast Whitespace Scan  

When engraving an image, LightBurn normally moves at the same speed across the entire image.
If you are engraving slowly to get a good burn, but the image contains a lot of empty space (white
space), this takes a long time. With the Fast Whitespace switch enabled, LightBurn will boost the
speed through blank areas to the speed you indicate, if it is faster than the current engraving
speed. This can save significant time.
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A note for Marlin users: Since Marlin treats G0 and G1 moves identically, this value is used to
specify the speed for rapid moves. If you do not set this value, LightBurn will use the same speed
as the G1 moves.

S-Value Max  

GRBL and Smoothieware use the S-Value (spindle speed setting) to control the PWM power
output to the laser. This setting is the number that corresponds to 100% power in LightBurn.
Smoothieware typically uses a value from 0 to 1 and supports fractional numbers in between.
GRBL defaults to 0 to 1000 for newer versions of GRBL, or 0 to 255 for older ones. The S-Value
Max setting in LightBurn must match your controller setting, or you'll either get not enough
power output (if LightBurn's setting is lower) or very small power numbers will set your laser to
full power (if LightBurn's setting is higher).

 

Z Axis Controls  

Enable Z Axis: turn this on to allow LightBurn to control the Z axis of your machine, IE the height
of the laser above the workpiece.

Note: enabling Z control means that LightBurn will always emit Z values for a running job, and
therefore requires that you set either the "Relative Z moves only" toggle below, or a material
height value on the main cut panel. If you to not set relative mode, and do not set a material height,
the default of 0 may cause LightBurn to raise your bed to a point where the workpiece could contact
the head of your laser.

Reverse Z Direction: Most DSP systems have 0 as the highest point, with positive numbers
moving the laser head further from the bed, however some systems reverse this. Toggle this
switch to change the overall direction for Z moves.

Relative Z moves only: This setting tells LightBurn to read the height of the machine when the
job starts, and uses that height as the starting point for all Z moves, ignoring any specified
material height. This is the simplest way to work, as you just set your focus manually, and
LightBurn will perform all moves relative to whatever height your machine is at when the job
starts. Note: for DSP systems this requires that you are connected to the machine.

af://n395
af://n399


Return to main page

Menu Commands  
If you don't know what a button / option does, hover the mouse over it. Tool-tips are often added
to help in explaining them better.

If a button doesn't seem to do anything or ever enable, it's probably a feature that's not written
or connected yet. There are a few of those - there is only one developer working on the coding at
the moment.

The toolbars and windows can all be dragged around if you don't like the layout. Whatever you
end up with is saved when you quit.

 

File Menu  

Edit Menu  

Tools Menu  

Arrange Menu  

Window Menu  

Language Menu  

Help Menu  

File Menu  

New  

Clicking "New" in the File Menu will clear any current project and create a new one. You can also
press "Ctrl + N" (Command + N on Mac).

Open recent projects  

This will open a list of the most recently opened files to choose from.

Open  

To open an existing or saved file, click on “Open” in the File menu or press "Ctrl + O" (Command +
O on Mac).

Import  

You can import any supported LightBurn files into the file you are currently working on. Click on
“Import” in the File menu or press “Ctrl – I” LightBurn supports importing the following file types:
svg, ai, pdf, dxf, hpgl, plt, png, jpg, bmp.
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Save  

To save a project click on “Save” in the File menu or press "Ctrl + S". Type the name you want the
file saved as in the dialog box that opens up. To save a file with changes, but still keep the original
file intact, click on the “Save As” icon in the File menu.

Export  

To export a file to a different file format, click on “Export” in the File menu. LightBurn can export
to SVG or AI format, though bitmaps and text are currently not exported.

Exit  

To exit LightBurn, click on the “Exit" in the File menu or press “Ctrl – Q”. You will be prompted to
save your file if you have unsaved changes.
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Edit Menu  

Undo  

To undo the last editing action done on the current file, click on "Undo" in the Edit menu or press
"Ctrl + Z".

Redo  

To Redo the last editing action done on the current file, click on "Redo" in the Edit menu or press
"Shift + Ctrl + Z".

Select all  

To select all objects in the current file click on "Select all" in the Edit menu or press "Ctrl + A" (or
Command + A on Mac).

Cut  

To one or more objects from the current file, select them and click on "Cut" in the Edit menu or
press "Ctrl + X". This will put the object on the clipboard, and remove it from the current file.

Copy  

To copy one or more objects, select them and click "Copy" in the Edit menu or press "Ctrl + C"
This will put the objects on the clipboard, but leave the original object alone.

Duplicate  

To duplicate a selection in place, select one or more objects and click "Duplicate" in the Edit menu
or press "Ctrl + D". This is an "in-place" copy and paste operation all in one, bypassing the
clipboard. This means if you already have something on the clipboard, it'll still be there after
using Duplicate. The duplicate is placed directly on top of the original.

Paste  
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To paste an object from the clipboard click "Paste" in the Edit menu or press "Ctrl - V". This will
place a copy of the clipboard contents in the current file. Note that LightBurn can paste text or
images copied to the clipboard from other software.

Paste in place  

To paste an object from the clipboard click "Paste in place" in the Edit menu or press "Alt - V". This
will place a copy of the clipboard contents in the current file in the same spot that it was in the
original file.

Delete  

To delete an object select it and click "Delete" in the Edit menu, or hit the Delete key. This will
remove the object from the current file.

Convert to path  

This converts a built-in "shape" object, like a rectangle, ellipse, or text, into lines and curves that
can be edited. Click on "Convert to path" in the Edit menu. The original shape information is lost,
so you won't be able to change text with the text tool after using this.

Close path  

In order to "Scan" (Fill) a shape with your laser, the shape must be a closed loop, where the
starting and ending point are the same. If the start and end points are very close, but not quite
connected, "Close Path" will move them together. Click on "Close path" in the Edit menu or press
"Alt + C"

Auto join selected shapes  

Looks at the start and end points of all the selected curves, and if any of them are close enough,
connects them together into a single shape. Useful when importing DXF files, which don't contain
connectivity information. Click on "Auto join selected shapes" in the Edit menu or press "Alt + J"

Optimize Selected Shapes  

Attempts to fit the selected shapes to arcs and lines within a specified error tolerance. Useful for
reducing the point count in a shape, or recovering arcs from software that exports them as many
small line segments.

Delete Duplicates  

This will delete duplicate items within the drawing, for example if two squares are identical and
one on top of the other, this will delete the extra square. This helps to minimize erroneous moves
and double-cuts.

Select Open shapes  

This will select all open shapes in the document.

Select open shapes set to scan  

This will select all the open shapes that are set to scan in the document.

Select all shapes in current layer  
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This will select all the shapes that are set to cut in the current layer of the document. Note that if
some of these shapes are grouped, the system may have to un-group them in order to select
them.

Settings  

Clicking on "Settings" in the Edit menu will open a Dialog box where you can enter information
about your laser and default application settings.

Device Settings  

After initial setup, you can access device settings by choosing "Device Settings".

Machine Settings  

You can access the controller hardware settings by choosing this option.

Debug drawing  

This is mostly an internal tool for LightBurn developers that shows the bounds of shapes being
drawn.

Convert to cut  

Also an internal tool for LightBurn developers - It converts the selected shapes into the cuts that
would be sent to the laser, and makes a new shape from the result. This is not how you produce
gcode / cuts for your machine, it's just a debugging tool. Click on "Convert to cut" in the Edit
menu or press "Ctrl + Shift + C"

Machine Settings  
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Tools Menu  

Many of the tools in this menu are also available as icons in the tool toolbar that by default, is on
the left side of the workspace. See Creating New Vectors for more information.

Select  

Click on "Select" to select objects in the workspace, or to access menus and toolbars.

Draw Lines  

Click on "Draw Lines" or press "Ctrl + L" to draw straight lines in the workspace.

Rectangle Tool  

Click on "Rectangle" or press "Ctrl + R" to draw rectangles in the workspace.

Ellipse Tool  

Click on "Ellipse" or press "Ctrl + E" to draw ellipses in the workspace.
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Edit Nodes  

Click on "Edit Nodes" or press "Ctrl + ~" to edit nodes of objects in the workspace.

Edit Text  

Click on "Edit Text" or press "Ctrl + T" to create or edit text in the workspace.

Offset Shapes  

Used to create new shapes that are offset from the current selection, inward or outward.

Weld Shapes  

Fuses multiple shapes together into a single outline.

Trace Image  

Opens a dialog box where you can trace the content of a bitmap image into vector graphics.
(Read more here)

Apply Path to Text  

If you select a shape and a line of text, this command will attach the text to the shape, so the text
follows the path. (Read more here)

Zoom In  

Click on "Zoom In" or press "Ctrl + =" to zoom in the workspace.

Zoom Out  

Click on "Zoom In" or press "Ctrl + -" to zoom out in the workspace.

Frame Selection  

Zoom the view to completely contain the current selection. (Ctrl + Shift + A)

Position Laser  

Click on "Position Laser" to allow clicking on the workspace to move the laser head to that
location.

Preview  

Click on "Preview" or press "Alt + P" to open the preview window. It will show the current laser
project and includes information on cut distance, rapid moves, and total time estimate. Cut lines
are in black and traversal moves are red. You can toggle the display of traversal moves on or off,
as well as shading by power level.

Rotary  

This will open the rotary setup dialog box. Use this to set up your rotary attachment.
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Arrange Menu  

Group  

Click on "Group" or press "Ctrl + G" to group the selected objects in the workspace.

Ungroup  

Click on "Ungroup" or press "Ctrl + U" to ungroup the selected objects in the workspace.

Flip Horizontal  

Click on "Flip Horizontal" or press "Ctrl + Shift + H" to flip the selected objects in the workspace
horizontaly.

Flip Vertical  

Click on "Flip Vertical" or press "Ctrl + Shift + V" to flip the selected objects in the workspace
vertically.

Align Centers  

Click on "Align Centers" to place the center points of the selected objects directly on top of each
other.

Align Left  

Click on "Align Left" or press "Ctrl + Shift + Left arrow" to align the selected objects in the
workspace to the left.

Align Right  

Click on "Align Right" or press "Ctrl + Shift + Right arrow" to align the selected objects in the
workspace to the right.

Align Top  

Click on "Align Top" or press "Ctrl + Shift + Up arrow" to align the selected objects in the
workspace to the top.

Align Bottom  

Click on "Align Bottom" or press "Ctrl + Shift + Down arrow" to align the selected objects in the
workspace to the bottom.

Align H-Center  

Click on "Align H-Center" to align the selected objects in the workspace to the center of the
horizontal plane.

Align V-Center  

Click on "Align V-Center" to align the selected objects in the workspace to the center of the
vertical plane.
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Move H-together  

Click on "H-together to move shapes like distribute, but keeps shapes together

Move V-together  

Click on "V-together to move shapes like distribute, but keeps shapes together

Move to Page Center  

Click on this to move selected objects to center of page

Move to Upper Left  

Click on this to move selected objects to Upper Left of page.

Move to Upper Right  

Click on this to move selected objects to Upper Right of page.

Move to Lower Left  

Click on this to move selected objects to Lower Left of page.

Move to Lower Right  

Click on this to move selected objects to Lower Right of page.

Grid / Array  

Click on "Grid / Array" to create an array or grid of objects in the workspace. A window will open
allowing you to enter the parameters for the array or grid.

Circular Array  

Click on "Circular Array" to create an array or grid of objects in a circle in the workspace. A
window will open allowing you to enter the parameters for the array.

Push forward in draw order  

Click on "Push forward in draw order" or use "Page up" key to move the selected object up one
level in the draw order. Usefull when trying to see objects on the screen.

Push backward in draw order  

Click on "Push backward in draw order" or use "Page down" key to move the selected object
down one level in the draw order. Usefull when trying to see objects on the screen. "Ctrl-PgDn" or
"Ctrl-PgUp" will send an object to the very bottom, or very top of the objects on the screen.

Break apart  

Click on "Break apart" to break selected object into individual parts. Return to top

Window Menu  
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Reset to Default Layout  

To arrange the windows and menus back to the original default layout, click on "Reset to Default
Layout" You can use the Window menu to toggle windows and menus on or off.

Return to top

Language Menu  

Choose the language you would like to have LightBurn use in this menu.

Return to top

Help Menu  

Quick Help and Notes  

Click on "Quick Help and Notes" or press F1 to access hotkey list, general usage notes and version
information.

Online Documentation  

Click on "Online Documentation to access the documentation for LightBurn.

Online Video Tutorials  

Click on "Online Video Tutorials" to access the tutorial videos.

Check for Updates  

Click on "Check for Upfates" to make sure you are on the most recent version.

License Activation and Trial  

Click on "License Activation and Trial" to launch the license dialog, where you can enter your
license key, or see the status of your trial period or license.

Enable Debug Log  

This is for the developers, turn on the log by clicking on "Enable Debug Log". The log file will be
written to your "My Documents" folder on Windows, or Documents on Mac, and is cumulative -
each time you enable the debug log it will append to any existing log, so it's a good idea to delete
it after you're finished.

Return to top
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Toolbars and Tool Windows  

The workspace has may toolbar and tool windows to make working with files fairly easy and
intuitive. Right clicking on the top bar of the app will allow you to toggle toolbars on or off, as will
using the 'Window' menu in the main menu bar.

 

Manipulating Tool Windows and Tabs  

You can undock a tool window and make it floating by dragging it away from the other tool
windows. You can also click the min/max button in the upper right of the tool window to undock
it.

You can dock the tool window by itself by dragging it to the right or left of the screen and
dropping it in an area that highlights blue when you hover over it.

You can dock the tool window as a tab by dropping it on top of another docked tool window.

You can close a tool window by clicking the X in the upper right of the tool window or by turning it
off in the toolbar context menu as seen in the Tools and Toolbars section above.

You can reorder tabs by clicking on the tab and dragging it left or right in the tab strip.

Return to Top

Tool Windows provide a grouped set of tools for various operations.  

Cuts
File List
Laser
Move
Shape Properties
Console
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Toolbars are similar to Tool Windows, but are a grouped set of icons for
various types of operations.

 

Tools
Numeric Edits
Arrange
Text Edits

Return to Top

Cuts  

The Cuts tool window is where you will configure most of your job. It contains layers of cut
operations that can be reordered and have various machine operations configured. Details of the
possible Modes and settings are covered in the Operations section.

A right click on a cut layer will cause the items that are on that cut layer to flash in the
workspace.
Double clicking a cut layer will launch the full settings editor for that layer
You can quickly select the Mode or set the layer Output and Hide options directly from the
tool window
You can quickly set the basic operation parameters in the Cut Info section
Clicking the up or down arrows on the right side of the tool window will move the selected
layer up or down in priority (as will editing the Priority value below)
Clicking the small left / right arrows to the right side of the tool window will store the
selected cut in the scratchpad, or apply the scratchpad setting to the selected cut. This is a
handy way to store and recall a default setting if you have your own preferred settings you
like to start from.
Right-Clicking on the Output or Show text above the cut list will let you quickly toggle,
enable, or disable that setting for all layers.

Return to Top

File List  
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This is currently for DSP controllers. This window lets you manage the files hosted on your
controller, if the controller supports this.

Hit the Refresh button to query your controller for the list of hosted files. You can select a file and
press Start to cut it, Delete to remove it from the controller, or Download to save it locally.
Pressing Upload will let you choose a local cut file to send to the controller (this is not the same
as the current job, which you can upload with the "Send" button in the Laser window - see the
Machine Instructions page for more details). Be careful with the Delete All Files button.

Return to Top

Laser  

The Laser tool window is used to interact with the connected device.
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This tool window provides most of the functions for interacting directly with your laser. The
commands are covered in detail elsewhere in the documentation. You can also enable the rotary
here, as well as change the job origin.

For a detailed explanation of the Start From options, see Coordinates and Origin

Return to Top

Move  

The Move tool window is used primarily for Jog and Home functions

Here you can manually jog your laser head to different positions by selecting one of the arrow
buttons around the home button. This will move your head by the set distance, speed and power
entered in the toolbox.
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You can also set or clear a custom origin or get the current reported position.

Note: If you have a Ruida controller, you will not see Set Origin, Clear Origin, or Set Finish
Position, as these are handled by the controller itself. LightBurn will generally show only controls
you can use.
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Shape Properties  

Shape properties is used for setting properties specific to a selected shape, or shapes. Some
properties appear on all shapes, like Cut Order Priority or Power Scale, and some are specific to
certain types of shape, like Radius on circles, or Corner Radius on rectangles.

Cut Order Priority allows you to tell the cut planner to cut certain shapes before or after other
shapes, when the Cut by Priority option is set in the Cut Planner optimization settings.

Power Scale lets you tell LightBurn to use a percentage of the selected power for a given shape.
This allows you to set different shapes within the same layer to a higher or lower laser power
percentage without creating a new layer. This is especially useful for creating test patterns and is
covered in detail in the Video LightBurn progress demo #9 - Power Scaling You can also choose
what direction the shape should be cut in. This will be used by the cut planner to determine the
cut direction.
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Console  

On non-Ruida machines, a console toolbox is available for directly inputting commands. You can
type a command in the text box and the console will output the results. Examples would be
manual G-Code commands or retrieving configuration details from your connected device.

Note, this is not available on non-gcode devices, like Ruida and Trocen controllers.
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Numeric Edits Toolbar  

This is primarily for changing the size, position, and orientation of the current selection.

The Lock icon is used to enable or disable aspect ratio locking. With the lock enabled, changing
the width of an object will also adjust the height, and vice versa. For example, if your object was
100mm x 50mm and you changed the width to 80mm, LightBurn would automatically change the
height to 40mm, maintaining the aspect ratio of the object. Turning off the lock allows the width
and height to be manipulated independently.

LightBurn's X & Y position, width, height, scale, and interval entry boxes now support expressions
and units. What does this mean for you?

If you type 1/2in, and you're in mm mode, it'll turn into 12.7. If you're in inch mode and type
1/2in, it'll become 0.5. You can use ft, cm, in, or mm, along with normal math symbols and
parenthesis (*/-+). You can combine them, so entering (1/2in + 3mm) * 2.5 + 1ft is valid. You can
type 1/300in in the interval box to have it convert "300 lines per inch" into an interval for you.
This should make working in mixed units easier.

The 9-point control selects the anchor point that objects resize from. For example, if you select
the upper-right dot, the upper right of the selection is anchored when resizing.

The small button on the far left of the toolbar allows you to quickly toggle between mm and inch
measurements in the UI. When using this toggle, only distance measures are changed - speeds
will always be viewed in mm.

Return to Top
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Tools Toolbar  

On the left of the workspace in the default configuration, there is a tool bar with many of the
commonly used tools. These are also duplicated in the tool menu at the top of the workspace,
and this menu also displays the hotkeys to quickly access them.

The tools are as follows:

Select  

Click on the "Select" icon to select objects in the workspace, or to access menus and toolbars. You
can also quickly get back to Select mode by pressing Esc.

Selection snapping  

When in selection mode, objects can be moved, scaled, or rotated by clicking on the various
marks that appear around the selection. You will occasionally see the cursor change if you hover
over a point of interest on a shape. This means LightBurn has found a 'snap point'. When moving
an object near another, snapping is on by default. LightBurn will snap your selection to other
object centers, end points of lines or curves, or center point of lines or curves, in addition to just
snapping to the grid. You can bypass the snapping behavior by holding the Ctrl key (Command on
Mac).

Draw Lines  

Click on the "Draw Lines" icon to draw straight lines in the workspace, or press Ctrl-L (or
Command-L on Mac).

Rectangle Tool  

Click on the "Rectangle" icon to draw rectangles in the workspace, or press Ctrl-R (or Command-R
on Mac).

Ellipse Tool  

Click on the "Ellipse" icon to draw ellipses in the workspace.
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Polygon Tool  

Click on the "Polygon" icon to draw regular polygons, like hexagons, triangles, pentagons, and so
on. The number of sides can be edited in the Shape Properties window.

Edit Nodes  

Click on the "Edit Nodes" icon to edit nodes of objects in the workspace, or press Ctrl-`.

Edit Text  

Click on the "Edit Text" icon to create or edit text in the workspace, or press Ctrl-T.

Position Laser  

Click on the "Position Laser" icon to allow clicking on the workspace to move the laser head to
that location.

Offset Vectors  

Click on the "Offset Vectors" icon to create new vectors that are an offset of the original vector
selected.

Weld, Union, Difference, and Intersect Vectors  

These four operations are covered in the Boolean Operations page.

Grid Array  

Create an array of copies of the current selection, arranged in a grid with editable spacing and
other options.

Radial Array  

Create an array of copies of the current selection, arranged in a circle, with editable spacing and
other options.

Edit Start Point  

Edit the point and direction that LightBurn will use to start cutting the selected shape, or shapes.

Note - These tools are covered in more detail in the 'Creating Vectors' topic.

Return to Top

Arrange Toolbar  

Return to Top

Text Options Toolbar  

This toolbar gives you access to settings on text objects, including font, size, spacing, alignment,
and more.

You can select the font, size, and also Bold or Italic options here, as well at the Variable Text mode
to use, if any.
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Height - sets the height of the font in the current units
HSpace - adjusts the horizontal character spacing as a percentage of the font size. Positive
numbers space the characters out more, negative numbers move them closer together.
VSpace - adjusts the vertical line spacing as a percentage of the font height. Positive
numbers increase the distance between lines, negative numbers reduce it.
Align X - chooses the horizontal anchor position of the text - Left, Right, or Middle
Align Y - chooses the vertical anchor position of the text - Left, Right, or Middle
Bold - Displays the font in bold typeface, if available
Italic - Displays the font in italics, if available
Welded - Enables automatic welding of characters. When characters touch or overlap, as is
common with script fonts, enabling this option will automatically weld the overlaps together.

The remaining two options are for Variable Text, like serial numbers, dates, and so on. More
information about Variable Text can be found here.

Return to Top
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Apply Path to Text  
A video tutorial for this feature can be found on our YouTube channel, here: Path to Text tutorial

To use this feature, create a single line of text, and a path or shape to wrap the text around, like
this:

Select both the text and the path, then go to Tools > Apply Path to Text, and the text will attach
itself to the path, like this:

You can change the horizontal and vertical alignment of the text (left/right/center), as well as edit
the path itself, to position the text the way you like. We recommend creating specific shapes for
the text paths, and setting them not to output so they are not part of the design that gets sent to
the laser.
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Hot Keys and Gestures  
Most feature hot-keys can be found next to the action in the menus.

General Usage Hot-Keys  

Mouse  

Selection: Left click, or band-box

Shift + click adds to the current selection
Ctrl + click removes from the current selection

Drag: Left-click & hold on an object, drag it

When dragging, Shift will keep the drag vertical, horizontal, or 45 degrees
When dragging, Ctrl means "don't grid / object snap"
When sizing, the default is retain the current aspect ratio, holding shift unlocks it.
When sizing, Control means "resize from center"

Zoom: Mouse wheel (zooms relative to the cursor)

View drag: Middle-mouse click and drag

Double clicking text Now auto chooses text mode and places cursor.

Keyboard  

View drag: Hold space-bar + left-click & drag (useful for Mac, or users without a mouse
wheel)
Delete: Backspace or Delete keys
Select Mode: Pressing the Esc key while in the workspace will return to the selection tool

Move  

Arrow keys move the current selection
Shift + arrow moves in large steps
Ctrl + arrow moves in small steps

Menu Hot-Keys  

File  

New Ctrl + N
Open Ctrl + O
Import Ctrl + I
Save Ctrl + S
Exit Ctrl + Q

 

Edit  
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Undo Ctrl + Z
Redo Ctrl + Shift + Z
Select All Ctrl + A
Cut Ctrl + X
Copy Ctrl + C
Duplicate Ctrl + D
Paste Ctrl + V
Close Path Alt + C
Auto Join Alt + J
Optimize Alt + O
Convert to Cut Ctrl + Shift + C

Tools  

Draw Line Ctrl + L
Rectangle Ctrl +R
Ellipse Ctrl + E
Edit Nodes Ctrl + ?
Edit Text Ctrl + T
Zoom In Ctrl + =
Zoom Out Ctrl + -
Frame Ctrl + Shift + A
Preview Alt + P

Arrange  

Group Ctrl + G
Ungroup Ctrl + U
Flip Horizontal Ctrl + Shift + H (or just 'H' in the edit window)
Flip Vertical Ctrl + Shift + V (or just 'V' in the edit window)
Rotate 90 clockwise Press '.' (decimal) in the edit window
Rotate 90 Counter-clockwise Press ',' (comma) in the edit window
Align Left Ctrl + Shift + Left Arrow (or just 'L' in the edit window)
Align Right Ctrl + Shift + Right Arrow (or just 'R' in the edit window)
Align Top Ctrl + Shift + Up Arrow (or 'T' in the edit window)
Align Bottom Ctrl + Shift + Down Arrow (or 'B' in the edit window)
Align Centers Vertically Ctrl + Shift + PgUp (or 'C' in the edit window)
Align Centers Horizontally Ctrl + Shift + PgDn (or 'E' in the edit window)
Move Selection to Page Center ('P' in the edit window)

 

Node Edit  

Smooth corner node S (while hovering over a node)
Convert line to smooth curve S (while hovering over a line)
Convert curve to line L (while hovering over a curve)
Convert smooth node to corner C (while hovering over a node)
Delete node D (while hovering over a node)
Delete line D (while hovering over a line)
Insert node point I (while hovering over a line or curve)
Break shape at point B (while hovering over a point)
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Help  

Help and Notes F1
Pressing F1 while hovering the mouse over the edit window will bring you to the
documentation page for the editing mode you're in.
Pressing F1 while hovering the mouse over some tools will show you help for that tool.

 

Complete List of LightBurn Hot Keys  

Hotkeys
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Workspace / User Interface  

Overview  

The user interface is grouped into several categories.

Tools and toolbars
Tool Windows and tabs
Workspace

Most tools and areas of the application have helpful tips if you hover over them.

Tools and Toolbars  

The toolbars and the tools they contain will allow you to manipulate your work. The function of
each tool is covered in the Toolbars and Tool Windows section.

You can enable or disable toolbars by right clicking on any open space on a toolbar to bring up
the context menu. This will allow you to turn on or off toolbars and toolboxes to fit your work
style.
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Tool Windows and Tabs  

Tool Windows provide a grouped set of tools for various operations. The function of each tool
window is covered in the Toolbars and Tool Windows section.

Manipulating Tool Windows and Tabs  

You can undock a tool window and make it floating by dragging it away from the other tool
windows. You can also click the min/max button in the upper right of the tool window to undock
it.

You can dock the tool window by itself by dragging it to the right or left of the screen and
dropping it in an area that highlights blue when you hover over it.

You can dock the tool window as a tab by dropping it on top of another docked tool window.

You can close a tool window by clicking the X in the upper right of the tool window or by turning it
off in the toolbar context menu as seen in the Tools and Toolbars section above.

You can reorder tabs by clicking on the tab and dragging it left or right in the tab strip.

Workspace  

The workspace is a versatile interface for manipulating your drawings. Some ways to interact with
the workspace include:

Drag and drop supported files onto the workspace to import them
Use the tools to draw vector shapes directly in the workspace
Manipulate the size and rotation of shapes and images
Move your laser head using the locator tool and clicking an area of the workspace
Review your machine and job origin
Type text
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New features are being added quickly so this may not be a comprehensive list of all of the
capabilities. Documentation will be added or updated as quickly as possible as new features are
made available.

Many hot keys have been added to increase your productivity. See the Hot Keys section for
details.
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Layers  
LightBurn allows you to set up multiple types of cut with different settings in a single job. The
different parts of the job are assigned to different layers in LightBurn by color, and the color
palette is shown at the bottom of the LightBurn workspace by default:

 

Assigning layers manually  

To use the layers palette, select an item in your workspace, like a shape or image, and then click a
color from the palette at the bottom of the screen. This color will now be assigned to a new layer
that you will see in the Cuts toolbox, normally shown on the upper right of the window. Any item
you assign to the same color will be placed in the same layer, and all the settings for that layer
will apply to it.

As seen in the image below, each shape and image is color coded to a different layer and each
layer is capable of having a different set of instructions for your laser.

 

Assigning layers automatically  
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When importing artwork from other software, LightBurn will look at your assigned colors and
attempt to match them to a color in the LightBurn layer palette. If an exact match is available it
will assign it. Otherwise it will assign unmatched colors to the closest available color in the
palette.

 

Layer options  

You can adjust the order of operations across layers by selecting an entry in the Cuts window and
then clicking the up/down arrows to the right of the window. By default, LightBurn will process
your layers in the order they appear in this window. (You can change this with the Optimization
Settings button)

This is a powerful tool to control which parts of your job are completed first and which are last
such as engrave and then cut.

As a drawing gets more complex it can become difficult to determine what is on a given layer. If
you right click the layer in the Cuts toolbox, the items in that layer will flash on the screen.

Also layers can be set to output or not by checking the Output checkbox. Turning this off will
prevent the layer from being sent to your laser but will be recognized for current position or user
job origination settings. Using this would allow you to place a representation of your work piece
as a guide for alignment and setup while not actually burning. Layers set not to output will dim in
the edit window.

You can also hide a layer, which will turn the visibility on the screen on and off and can be helpful
when working with complex drawings.

You can quickly enable, disable, or toggle the Output or Show state of your layers by right-clicking
the column header in the Cuts toolbox:

 

Layer memory  

Layer palette colors will retain a memory of the last setting used. If your last job used black for
trace, red for scan and blue for cut with specific power and speed settings, LightBurn will
remember that the next time you assign those colors to a layer.
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Material Library  
LightBurn's Material Library provides a way to store and organize lots of cut presets, and have a
way to quickly apply them. This is entirely user-generated - You set up a cut layer however you
like and save it to a Library. You set a material type, thickness (if appropriate), and a short
description.

Any Library setting can be applied to a cut layer by selecting the library entry and assign it to the
layer. Settings are copied, so if you need to make edits to the setting you won't hurt the copy in
your library - you can edit those independently.

 

Understanding Material Library  

Material Library is a simple yet powerful component of Lightburn intended to assist in the
management of the laser cutting process.

The first time you launch LightBurn, an empty Material Library is automatically set up and ready
for new entries. You can easily add to, edit and manage cut settings in this library. Saved libraries
can be loaded and shared from local or network accessed and even cloud based storage for
convenience. To get started, make sure you can see the Material Library window.

In the top menu, select "Window" to ensure that "Library" is checked on. If not, select it to
turn the window on. This will display the Material Library window in the lower-right of the
display next to a box called "Laser".

 

Create new from layer  

LightBurn makes it easy to build out your library using the current cut settings assigned to any
cut layer.
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1. Select one of your cut layers then click the Create new from layer button in the "Library"
window.

 

2. Fill out the details sheet providing a Name, Thickness (if appropriate) and a short Description
of the cut layer parameters. Once completed, click the Ok button to save this new entry into
your library.

 

3. Now you can use this new entry titled "Birch Ply" anytime in the future and easily assign it to
a new cut layer.



There are several helpful ways to facilitate adding to and managing your library covered later in
the "Manage existing Library" section below.

 

Save a Library  

As you fill out the Library with your favorite materials, it is always a good idea to periodically save
your additions. To do this, click the Save button.

 

Assign Library settings to layer  

Now that you have some entries added to your library, you can use them to quickly and easily
apply these settings to your work. Settings are copied, so if you need to make edits to the setting
you have applied you won't hurt the originals in your library.
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New Library  

Depending on your workflow, you may find it desirable to have several libraries to work from. You
can start a new Material Library anytime by clicking the New button at the lower-right corner of
the "Library" window. Now you are presented with a new, blank library ready to fill out and save.

 

Load a Library  

Selecting Load provides access to your previously saved Libraries. Once clicked, a file finding
window will open allowing you to point to a saved library. Select library of choice and click the
Open button. Your chosen file will then become the active library for use.
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Manage existing Library  

Existing Library entries can be managed in several helpful ways. Changing existing cut settings
and discriptions, quickly duplicating entries, removing unwanted entries or producing copies of
the entire library can be done in a snap.

Note: These items are only selectable when "Description" is selected.  

 

Edit Cut  

Click Edit Cut to open the "Cut Settings Editor". This allows you to change any of the cut settings
as you would normally and saves them back to the library.

Edit Description  

Click Edit Description to modify the Name, Thickness and Description for the highlighted entry.
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Duplicate  

Click Duplicate to create a copy of the highlighted entry. This can be helpful in quickly adding to
your library.

Hint: Combined with Edit Description and Edit Cut you can keep the same "Material Name"
and "Thickness" to create 'nested' entries (e.g. 3mm cut, scan and image). Keeping just the
"Name" while changing the "Thickness" allows nesting of different thicknesses of the
same material.

 

Delete  

Click Delete to remove a single cut setting entry from the library.

Save As  

Click Save As to create a complete copy of your active library and saves it under a new name of
your choice.

 

Advanced Usage  

Multiple machines/users access to shared Library  

Multiple machines can access a single Material Library file hosted on a network drive or from
cloud service storage (e.g. Dropbox, Google Drive, iCloud, OneDrive, etc.).

1. Create a library on one machine and save it to your network or Google drive, DropBox, etc..
2. Point to that saved library file after hitting 'Load' in the 'Library' screen of LB for each

machine.
3. If you edit that library the changes will be there of both machines as they are pointing to the

same file.
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Laser Operations  
The basic operations of any device can be categorized in one of two ways: Cut and Scan. These
two options combined with variations in power and speed can achieve a variety of results.

Settings will vary from machine to machine and acrosss different materials. It is recommended to
test your settings on a scrap piece of the same material as your final work piece before your final
run.

Please Note: Cut speeds have been limited to 2000mm/s (or equivelant) This will prevent issues
of entering too high of a speed which we are sure your machine will not like.

To the right of the cut window you will see 4 arrows. The up and down arrows allow you to
change the order of the highlighted cut or scan layer, and the right and left arrows allow you to
copy cut or scan settings into the cache, and write those cached settings into a cut or scan layer.
Useful for copying settings from one layer to another.

Common Settings
Line
Fill
Fill+Line

Common Settings  

Output  

Output is an on/off selection. By default this setting is on for a layer. This means that the laser
will output the contents of the layer. Turning this setting off will skip creating instructions for the
layer and the layer will be ignored. This is useful for alignment lines or other content that should
not be in the end product.

Air Assist  

This is also an on/off selection. If your machine is capable of turning air assist on or off
automatically, set this to on to enable your air assist or off to keep it off. If your air assist is always
on or manually controlled, this will have no effect.

Speed  
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Speed is the feed rate when the laser is firing. This does not affect the feed rate for rapid move
(IE moves traversing between cuts). By default, speeds are shown in mm/sec, however if you are
using a lower power diode laser, you can change this to mm/minute in the settings.

Max Power  

This is the maximum percentage of power that the laser will produce during the cut.

Min Power  

For DSP devices (not GCode based controllers) this is the minimum percentage of power that the
laser will produce during the cut. On Ruida machines, this is power setting that will be used
during a cut when the machine slows down to reverse direction, or make a sharp corner. You
should normally set this number to just above the threshold where your laser fires. Setting it the
same as Max Power means the laser will not change power output as the speed varies, which will
result in a poorer quality cut, particularly on thinner materials.

**Please note: Ruida controllers have a “Start Speed” value in the controller that is the point
where they start ramping power from Min to max. Below that they just use min power. If you’re
cutting slow, set min/max to the same value.***

Mode  

This can be used to choose the operation for the layer. Cut, Scan, or Scan+Cut

Line  

Line will trace the laser along the vector path. Depending on the power and feed rate settings,
this can be used to cut through a material in single or multiple passes, using high power, or to
simply mark a line on the surface with lower power.

Line Settings  

Enable "Cut-Through" Mode  

This setting is only available for Ruida and GRBL based machines. Enabling this setting will allow
the laser to dwell in the same position after initially firing or before turning off based on the
settings below, and is useful for piercing thick materials before the cut starts.

Start pause time (ms): Number of milliseconds to fire the laser before moving
End pause time (ms): Number of milliseconds to fire the laser at the end of a move
Power (%): Percentage of laser power while paused

Other settings  
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Kerf offset: Allows you to shift the cut inward or outward from a closed shape to
compensate for the diameter of the beam. This is useful when making parts like inlays or
finger joins.
Z Offset: Specifies an amount to offset the laser head (or bed) for this cut. Useful for
defocusing, or pushing the focus point into deep materials for cutting.
Number of Passes: The number of times the laser will trace the same path
Z step per pass: Increase or decrease bed height for powered Z bed

Perforation Mode  

Perforation mode allows cutting perforated or dotted lines (lines with gaps) without having to
change the source artwork. You specify how long you want the cut, and how long you want the
gap (skip), and LightBurn will alter the output when generating the cut.

This is most commonly used to create fold lines, but can also be used for living hinges or creating
bridges or tabs in your designs. For example, setting a very long cut length, with a very short gap,
will insert periodic gaps in the cut. The perforation mode is smart - if possible, it will make sure
your shapes have at least one gap in them if the cut length is longer than the line to be cut.
Perforation mode is also useful if cutting very delicate material. By setting short Cut and Skip
values, you can reduce the amount of power the laser outputs to the material, much like
dithering. This can reduce scorching on paper, or melting on thin plastics from overheating.

Dot Mode  

Dot Mode is similar to perforation mode, shown above, but the laser stops for each dot, fires for
a set amount of time, and then continues.

The firing time is specified in milliseconds (thousandths of a second) and the spacing will be in
whatever your distance units are set to (mm by default, or inches if you've changed it).

 

Reset To Default  

Clicking on the Reset to Defaults button, will reset all cut settings to their default settings.

Fill  
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This option will fill the interior of a vector similar to engraving a raster image. When you select Fill
from the Mode options, the settings below will become available.

Bi-Directional scanning  

This is an on/off value. With bi-directional scanning on, the laser sweeps back and forth, cutting
from left to right, then right to left, and back again. With bi-directional scanning off, the laser fires
only in a single direction, say left to right, then returns without firing, then fires again from left to
right, and so on. The images below illustrate the difference - the black arrows show the direction
of the laser firing, and the red lines show the path of the laser between firing moves (also called
traversals). Bi-directional ON is usually preferred, because it is twice as fast.

Bi-Directional ON  

Bi-Directional OFF  

Cross-Hatch  

Cross hatch is an on/off value. By default this is off which means your laser will only burn in the
direction you have chosen. By turning this setting on you will get a second operation that will
burn lines at 90 degrees to the first set, creating a cross-hatch pattern as shown below. This is
mostly useful at higher interval settings as a way to give the appearance of a filled shape, while
taking less time.

Cross-Hatch Off  
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Cross-Hatch On  

Overscanning  

When engraving, the head is scanning back and forth. Because the laser has to accelerate and
decelerate the head at the beginning and end of each line, on machines with limited power
control this can cause darker edges than expected.

Overscanning generates extra moves, past the ends of each line, switching the laser off before it
fully stops, or even before it begins to decelerate, allowing the entirety of the engraving to
happen at the desired head speed and then decelerating while the laser is not burning. The
overscan number is a percentage of your cut speed - the default setting is 2.5%, meaning a cut at
100mm/sec will move an additional 2.5mm past the last cut with the laser off.

Note, Overscan is applied automatically by DSP hardware, like Ruida and Trocen controllers. This
setting is only available for gcode based systems which do not do this automatically.

Line Interval  

Line interval is the spacing between scan lines. The lower this value, the less space will be left
between successive passes. Lowering this value can create a slight overlap causing the laser to
slightly trace over the previous line. Setting a higher value will leave untouched material between
passes leaving visible scan lines. This is roughly equivalent to stepover for a CNC.

Lines per Inch  

This is simply a different way to represent the Line Interval value above - more lines per inch is a
smaller interval, and vice versa. Lines per Inch is a more intuitive number for many.

Ramp Length  

Setting this value controls the length of the ramp, or slope, on the sides of an engraving. Zero is
the default, meaning that engravings will have vertical walls. If you create stamps with fine
details, using a non-zero value for the ramp length will produce a ramp (from Min Power to Max
Power) as the engraving moves away from the edges of your design, producing sloped walls that
can help stabilize the stamp when in use.

This image shows a preview of the difference between an engraving with ramp applied, on the
left, vs an engraving with no ramping, on the right:
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Scan Angle  

The default scan angle is 0. This will produce scan lines along the X path only. By introducing a
scan angle, your laser head will track at the selected angle using both X and Y during operation.
As you change this angle, the graphic will show you the expected result.

0-degree scan angle  

30-degree scan angle  

On Ruida hardware, scan angles that are multiples of 90 degrees are supported natively by the
hardware and will automatically overscan for you. Other angles are scanned using standard
cutting commands.

Note: By default, LightBurn scans shapes from bottom up, because most laser systems exhaust
in the rear, and this prevents smoke from being pulled across the freshly cut region. If you wish
to scan a shape from top to bottom, simply set the scan angle to 180 degrees.

 

Z-Offset, Number of Passes, and Z-Step per pass  

These options behave identically to their counterparts in a standard cut.

Scan all shapes at once  

This setting tells the scanner to group all shapes within a cut layer together and scan them all at
once. In most cases this is faster than scanning individually, if your laser is fast.

Scan shapes individually  
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This will scan each distinct shape in your layer one at a time. For users with slower moving lasers,
this will occasionally be faster than scanning shapes together. For example, if you have two filled
shapes on opposite sides of your work area, filling one, then the other is probably faster than
continually scanning back and forth across the work area.

Scan Groups Together  

This setting will treat grouped objects as a single unit for the purpose of scanning, allowing you
the flexibility to choose which shapes get scanned together. For example, if you had 10 small
shapes on the left side of your work area, and 10 more on the right side, scanning all shapes
together would be slow, but scanning each one individually would be slow as well. Grouping the
left objects into a group, and the right objects into another group, then using "Scan Groups
Together" allows you to scan the 10 left objects in a single pass, then scan the 10 right objects in
another pass, without having to traverse the entire work area.

Flood Fill Scanning  

This option is intended for use with slower machines where traversing is more time consuming
than reversing direction. It will prefer direction changes over long traversals, and will save
scanning time if the machine has a slow rapid speed, or quick acceleration. This can be used with
image scans as well, but the cost to compute the path can be very high - use sparingly, and only
with very simple image modes like threshold. It is worth noting that Flood Fill is affected by the
"Scan all at once", "Scan together", and "Scan groups" settings, and it can also produce paths that
are quite erratic, seemingly skipping lines at random. It will eventually go back to fill them in, so
don't panic if you see this happen. It is a good idea to use the preview (and move the slider) to get
a feel for how a Flood Filled job will progress, because it can be unpredictable.

Note the flood fill option is not available for DSP controllers at this time because the paths
generated confuse the hardware. We are investigating this to see if we can correct it.

Fill+Line  

Fill+Line, as the name suggests, combines the fill and line operations. In order of operations, the
fill will happen first followed by the line. This can be used to cut out a part once the fill is
complete or simply emphasize the outline of the part before moving on to the next operation.

When you enable Fill+Line you will get the additional settings below. See the Line section for a
description of each setting.
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Cut Optimization Settings - Cut Planner  
Video Tutorial on YouTube - Click here

The cut planner gives you a great deal of control over the ordering of your cuts - you can let
LightBurn try to choose the best path for you, order it piece by piece yourself, or somewhere in
between. The new options are powerful, and we'll have a video coming soon to demonstrate
them. If you have "Order by Layer" as the only entry in the list at the top (the default), it will
behave the way you're used to. After selecting your choices in the cut planner, use the Preview
(Alt-P) to see how your choices have impacted things by using the slider at the bottom of the
window.

Access these settings by pressing the Optimization Settings button shown here:

 

The settings are displayed in this dialog (and the defaults are shown here):

Order By  

You can select what the initial order parameter will be. You have a choice of Layer, Groups or
Priority. As well you can use a combination of these three choices in any order you wish.

Order By Layer  
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If you choose Order By Layer, the cut planner will apply all optimizations to the first layer, then
the second layer, and so on.

Order By Groups  

If you choose Order By groups the cut planner will apply all optimizations to a Grouped object,
then the next Grouped object, and so on.

Order By Priority  

If you choose Order By Priority, the cut planner will apply all optimizations to the objects with the
highest priority (Assigned in the Shape Properties Window) first, then the next lowest and so on.

 

Optimizations  

Cut Inner Shapes First  

As the name implies, if there is an object within another object, and both are being cut, it will cut
out the inside object before the outside one.

Cut In Direction Order  

This will try to cut the shapes in your project in the specified direction - top to bottom, left to
right, etc.

Reduce Travel Moves  

This will have the cut planner try to order the cuts in a way that it will choose objects beside each
other to try and reduce non cutting travel moves.

Reduce Direction Changes  

The cut planner will try to choose cuts that allow it to keep moving in the same direction.

Choose Best Starting Point  

Allows the system to start a cut at any point within a shape, not just the first point. Works best
when "reduce travel moves" is also enabled.

Choose Corners, If Possible  

The cut planner will attempt to start a cut at a sharp corner to minimize burning or staining on
the surface of an item.

Choose Best Direction  

The cut planner will attempt to choose the best direction to cut in.

Remove Overlapping Lines  

The cut planner will remove lines that overlap each other that would cause the laser to cut in the
same place twice.
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Machine Instructions  
Generating a file of machine instructions is automatic. The type of file will depend on the device
you've chosen, G-Code for machines that use it, RD files for Ruida machines, and so on.
Generation of the file happens on demand, when you press the Start or Save buttons, and is
generally very fast.

Drawing in a layer or importing a vector file will automatically generate the instructions based on
the settings for that layer.

Importing an image will automatically generate a raster scan path for the image.

Saving and Importing Instructions  

You can save the instruction file that was generated by clicking on the Save button. Save G-Code
or Save RD File depending on your selected device. This will prompt you for a location to save the
generated file for review. LightBurn can also send a file to store on the device for running later by
clicking the Send button. This is currently only supported on Ruida controllers, but will be
expanded to include Smoothieboard support in the future.

You can import a previously generated instruction files by clicking on the appropriate Run button.
Run G-Code or Run RD File again depending on your selected device.

G-Code Console  
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For devices that are capable, a G-Code console may be available to you. This will allow you to
directly input and execute g-code commands. Enter a g-code command in the text box and
pressing return will send it to the connected device.



Return to main page

Coordinates and Job Origin  
There are a couple different ways to tell LightBurn how to cut the project within the work area of
your machine. You choose them in the "Start From" box on the Laser tab:

Absolute Coordinates  

Absolute Coordinates is the simplest - The page grid you see in the main editing window
represents your machine's work area. Anything you place in that area will be cut in the
corresponding place on your machine. Users with small lasers like the K40 will likely find this the
simplest and most intuitive option.

In the image below, the two circles placed in the middle of the work area will be cut in the middle
of the machine work area. The green square in the lower-left of the image represents the Job
Origin, and the red square in the same place shows the Machine Origin. In "Absolute
Coordinates" these are always in the same place.

Current Position  

Current Position is probably the next easiest to use. Your job cuts relative to the current position
of the laser head when you hit the Start button. You use the "Job Origin" value in the Settings
window to tell LightBurn how to position the job relative to the laser.
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In this image, we're starting from the Current Position, with the Job Origin set to the lower left:

Notice that the green "Job Origin" indicator has moved. This represents the position of the laser
when you start the job, so the laser is going to move slightly up and to the right from wherever it
is, cut the two circles, and go back to where it started.

Imagine that you wanted to cut this amazing two-circle pattern onto a beverage coaster or a
phone case. Lining it up like this is not easy. If you change the Job Origin setting to "Center", you
get this instead:

Now the job is going to be cut centered around the current position of the laser head. If you
position the laser directly over the center of the item you want to cut, the resulting image will be
centered on the item.

Using Current Position and Job Origin together lets you line up a cut on a piece of material with
ease, once you understand how it works.

User Origin  
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User Origin works almost exactly the same as Current Position, except that the starting location
is "programmable". Some lasers have an "Origin" button on them (like Ruida controllers). GCode
based systems use the "Set Origin" button in LightBurn to do the same thing. You jog your laser
to the position you want your job to start from, hit the "Set Origin" button, and then you're free to
move the laser around again. If you specify "User Origin" as the "Start From" value, the laser will
move back to that programmed location and start the cut from there.

Finish Position  

LightBurn gives you the control of where you want the head of the laser to return to after a job is
finished. By default it will return to 0,0 however this is not the optimal location for some
machines.

To change your finish position, go to the Move tool window and use the arrows to reposition your
laser head to where you would like it to return to on job finish. Then click the Set Finish Position
button. Your machine will now remember that spot for future jobs. This can be reset at any time
by repeating these steps for a new location.
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Rotary Attachment Setup  

This will walk you through setting up and using your rotary
attachment

 

Click on the Tools menu, Rotary Setup link and it will open the rotary setup dialog box.

1. If using a Ruida controller, disconnect the Y axis stepper connection and connect the rotary
attachment to the Y axis. If using Smoothie or Grbl, C3D, or Smoothieware controllers, click
the "A" axis selection. (See below on how to configure your controller steps before you
proceed)

2. Choose whether you have a chuck style or roller attachment.
3. Tick the enable rotary check box.
4. In the steps per revolution box, enter the number of steps it takes your attachment to make

one full revolution.
5. Enter either the diameter of the object to be engraved or it's circumference, the other value

will be automatically calculated.
6. Align your object under the laser head in a position where the X axis will start and rotate the

object in the rotary attachment to the point where you want the Y axis to start engraving.
7. When using the rotary, it's generally a good idea to use "current position" as the "Start From"

setting.
8. Click start and watch the magic happen.
9. Remember to uncheck the use rotary attachment check box once you are finished so that

you do not mess up your next regular project.

Some general notes on using a rotary attachment:

If the object slips on the rollers of a roller type attachment, wrap the rollers with some sort of
non-slip material or even rubber bands.

You can also try placing some weights inside the object such as ball bearings or other small
round objects, this will help press the object against the rollers.
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Notes for C3D, Smoothieware or GRBL users:  

Before configuring the above, you will likely need to set up the rotary axis on your controller.
LightBurn sends rotary moves as angle values, and the GCode controller translates those angles
into actual movements. To do this, it needs to know the correct number of motor steps to take
for one degree of movement on the rotary motor.

If you have a Cohesion3D, Smoothieboard, or other common GCode based controller, the
number is usually 200 times your microstepping multiplier (usually 8 or 16) times any gear
reduction, divided by 360.

For a Cohesion3D or HolgaMods rotary, this is usually

3200 steps (200 x 8 micro steps x 2x reduction) / 360 = 8.88888888 steps per degree 6400 steps
(400 x 8 micro steps x 2x reduction) / 360 = 17.7777778 steps per degree

The steps per degree number, along with acceleration and maximum speed will need to be set in
the appropriate location for the controller. With Smoothieware, it would be the 'delta' settings in
the config.txt file on the controller. For GRBL, it can be accessed in Edit > Machine Settings in
LightBurn, under vendor settings for the A Axis.
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Using a camera with LightBurn  
LightBurn includes a camera feature which allows a USB connected camera to be used in a
couple of different ways:

Monitoring your laser
Positioning designs on material
Tracing artwork directly from the bed of the laser

 

Using the camera as a monitor is simple - enable the Camera Control window (right-click on any
window or toolbar and choose "Camera Control" from the pop-up).

You'll be presented with a window that looks like this:

If your system has a compatible USB camera connected, it will appear in the Camera drop-down
box. Select the camera, and the view from the camera will appear in the window, as shown:
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The image from this camera is very distorted, because it is uses a fish-eye lens to achieve a very
wide field of view, and it's mounted at an odd angle for use with the laser. LightBurn can counter
both of these, and simulate a top-down view from nearly any camera. It takes a bit of effort to set
up, but it's well worth it.

Camera Calibration  
There is a YouTube video of the calibration process here: LightBurn Camera Calibration
Walkthrough

In order to use the camera for work placement, it's necessary to "teach" LightBurn how to
remove the distortion from your camera lens, and where your camera is in relation to the work
area of your laser. The first part of this is accomplished in the Lens Calibration wizard.

You will need to download and print the following image: Calibration-Circles.png

The circles image will be approximately 148mm x 105mm (5.8" x 4.1"), and should have at least
6mm (1/4") of white space around the pattern.

Mount it to stiff card, foam-board, or wood, so the image remains very, very flat. If the image is
curved, it will affect the calibration process and reduce the accuracy.

The Camera Lens Calibration wizard  

Camera Lens Calibration uses series of captured images of a known pattern. The software
analyzes how the pattern appears in the images, and compares that against its internal
knowledge of how the pattern should look. It determines the amount and shape of distortion
produced by the lens of the camera, and computes an inversion for this distortion.
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Note: This process is dependent only on the camera and lens, not on its placement in your
machine - as long as the camera and calibration pattern are perfectly still, you do not need to
mount the camera in the machine to perform the lens calibration. If the calibration image cannot
be held at the appropriate distance to match the shown image in the display, you may shrink or
enlarge the printed pattern.

It is best to have good, consistent lighting for the capture process, and the camera should be in
focus. A fuzzy image, or shadows falling across the calibration pattern will make the process
much harder, if not impossible.

Open the "Tools" menu and choose "Calibrate Camera Lens" from the menu. You will be
presented with a screen like the one below.

Choose your camera in the list, and you'll see the view from the camera in the area to the left.
With the correct camera selected, click Next.

The view will change to include a capture button, and a helper image to show you how to position
the printed pattern for capture. For the first capture, place the pattern in the center of the field of
view of the camera, with the printed face of the card pointed directly at the camera, as shown in
the small view up top. If you cannot easily match your capture image with the suggested image,
you may need to adjust the scale of your printed card, or leave the camera out of the machine for
lens calibration.



 

Click the Capture button (highlighted above) and you should see something like this: (note that
we've removed the camera from the machine for this one)

Above the image on the right you see:

Image 1 (1600 x 1200) : Pattern found - Score: 0.09 - Great! Click Next

This tells you:

The image was successfully captured



The resolution of the captured image is 1600 x 1200 (higher is better)
The calibration pattern was found in this image
This image scored very well - Lower scores are better. In this image, after distortion removal,
the positions of the dots in the image align with the positions of the real dots with an
average error of only 0.09 pixels - That's very good, and well within our desired score of 0.3
pixels of error.

Notice that in the gray image that appears to the right, the pattern of circles is not distorted,
though the image around them is considerably worse (look just above the dots). That is
temporary, and the result of only having a single calibration image to work with. As you progress
through the remaining calibration steps, you'll capture more images with the pattern in different
parts of the camera view, filling in more information about how your lens distortion affects the
image.

If the calibration pattern is not found, LightBurn will tell you so. Make sure the pattern card faces
directly toward the camera, and occupies roughly the same amount of view area shown in the
"suggestion" image. The pattern card should be parallel with the sensor of the camera, as shown
in the upper-left graphic in the capture window, though the pattern can be rotated within the
view without affecting the calibration if this is easier, as shown here:

 

As you advance through the captures, the suggestion image will update. The first five images are
the center of view, followed by bottom, left, right, then top. If your camera has a very strong
fisheye effect, it may be necessary for you to move the non-center images inward a little to get a
successful capture. This is ok.

The final four images are the corners, and these can be difficult to capture with high-distortion
cameras. If your first 5 images score very well (below 0.3) you are allowed to skip the final four
images (the 'Next' button will shows as 'Skip' in this case). If you are having trouble capturing the
last four images and don't have the option to skip, you can place the card anywhere within the
view and capture that instead - We don't verify that your placement matches what we're
suggesting.



Even after only a few good captures, the image on the right should appear to be free of lens
distortion, as shown here:

A poorly calibrated result will still show lens distortion, and may have other artifacts, like the
"wobble" seen in the lower-left of the gray image below:

If you don't get it straight away, you can re-capture the current image, or just go back to the
beginning and try again. It can take a few tries to get a feel for how to align the card with the
camera to get the lowest score.

When you have advanced through all the steps, and you are satisfied that you have a good
calibration result with a nicely undistorted image, click Finish to save the results. You can also
click the "Align Camera" button in the final page to take you to the next wizard automatically.

 

Aligning the Camera and Workspace  
Now that the camera is calibrated, you can move on to the next step, camera alignment - telling
LightBurn where your camera is in relation to the workspace of your machine. From this step
forward, it is very important that the camera not move in relation to the machine. It is possible to
mount the camera to a movable piece of your laser, like the cover, as long as the position of the
camera is the same when you use it as it is when you calibrate the alignment. The camera should
be firmly mounted pointing at the center of the machine work area, with a clear view.

Cutting the Alignment Markers  

In the Tools menu, choose "Calibrate Camera Alignment" to start the alignment wizard. Choose
the same camera you did in the Lens Calibration wizard.
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After selecting the camera and verifying that you can see an image from it, click Next and you'll
get to this screen:

This page uses your laser to cut a target pattern onto a piece of material, such as card stock,
paper, cardboard, or thin wood. The pattern that will be cut is shown on the right side of the
display.

LightBurn supports many different types of laser, so we need you to specify how fast and at what
power to do this cut. You should choose settings that will make a dark surface mark on the
material, but not cut through it. The "Support Height" and "Material Thickness" values can be set
to zero if you do not normally use these values when cutting.

Follow the directions in order - set the numbers appropriately, use the Frame button to check
that the material is aligned with the cut, and click Start when you're ready. If the cut comes out
incorrectly (too light, or too strong) change the settings and try again. Your results should look
something like this:



When you have a good result, click next.

Capturing the Target Marker Image  

From this screen, you're going to capture the alignment image. It is very important you do not move
the target marker image after cutting it. Use the jog or "send to corner" buttons here to move the
laser out of the view of the camera. When the camera has a clear view of all four targets, click the
Capture button. You should see an undistorted version of the camera view appear in the right
side of the window, with all four corner targets visible, as shown below:
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Marking the Targets  

On this page you 'tag' each of the targets by double-clicking in the center of each one in order.
You can pan and zoom around the image using the same controls as the LightBurn edit and
preview windows. When you double-click, a red '+' mark will appear. Place a marker in the center
of each of the four targets, in the order they are numbered (1, 2, 3, 4). If you place one incorrectly,
you can double click near it to shift it around, or click "Undo Last" to remove it and try again.
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Place each marker as accurately as you can. You can see the ideal placement here:



When you have placed all four markers in sequence, zoom back out and verify that all four are
visible and clearly centered on the targets, like this:

Click Next to finish the marker placement screen and click Finish to complete the process and
store the results. You're done!

 

Now that everything is aligned, open the Camera Control window again, and simply click "Update
Overlay" to capture and project whatever happens to be in the camera view onto your
workspace, as shown:



Click the "Fade" button to dim the background image, or the "Show" button to toggle it off and
on.
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Print and Cut with LightBurn  
"Print and Cut" normally refers to the ability to print a design on a printer, then have it
automatically cut it out with a blade or laser cutting machine by using registration marks on the
print to align the cut to it.

Note: In order for the output to be positioned correctly on your laser, you must use Absolute
Coords as the positioning mode, otherwise the output will not match the position of the print.

 

As an example, take this design, printed on sticker paper:

I've imported the same design into LightBurn, with the cross-hair markers, and added an outline
to the dragon using the offset tool:
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The important part in this file is the two cross-hair marks - these are the target marks that you
will use to align the cutting path with the printed sticker. They don't have to be cross-hairs, but
these are simplest to align with, as the center of the selected object is what is used for alignment
when recording positions.

 

The red lines are set as cut vectors, with an appropriate power and speed, and the black lines can
either be set not to output, or simply deleted.

 

After placing the printed version of the file in the laser, follow these steps to align the laser
output with the print.

 

Using the red-dot pointer of your laser, jog the laser head to align with the center point of one of
the two cross-hair marks.

In LightBurn, select the same cross-hair mark, then go to Tools > Print and Cut > Set First Target
Location, like this:

 

Now, jog the laser to align the red dot pointer to the center of the second marker

In LightBurn, choose Tools > Print and Cut > Set Second Target Location:



You will notice that in the above image, the menu option for 'Set First Target Position' has the icon
highlighted as well - this means that the First Target Position is set and active.

 

After setting both targets, the menu will automatically enable the 'Align Output to Targets' option
for you, like this:

You will also see the "(Print & Cut mode)" message in the status window, like this:

 

If you preview at this point, the orientation of the preview should match that of the print on your
laser:

In the above image, you can see the preview image is rotated slightly clockwise, matching the
orientation of the printed image in the laser.

 



Note: In order for the output to be positioned correctly on your laser, you must use Absolute
Coords as the positioning mode, otherwise the output will not match the position of the print. The
accuracy of the result will be affected by the accuracy of your red-dot pointer, so using one that is
either a cross-hair beam pointer or a red-dot marker that is in the same beam path as your laser
is ideal.

After running the job on the laser, this is the result:
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Creating a Power Scale Test Grid  
Create a 15x15mm square. Set its speed to your lowest speed to test and set power to whatever
100% on your laser is (i.e. if your max power should be set to 70% so as not to overpower your
tube (i.e. go above the recommended MAX milliamps) then set power to 70%).

Now, use the grid tool to create a row of as many power levels as you want to test - let's say 10
for this example.

Now, select the left most square and open the Shape Properties tab. Set the Power Scale to your
lowest test power - 10% to mimic what you have above. Note that Power Scale applies to the
layer power, so 10% is 10% of 70% (if that's what you set above).

Select each square and simply increase its Power Scale by your increment - 10% in this case.

That was the hard part! Now, select the entire row and use the Grid tool to create the number of
rows you need for the Speeds.

Select each row and put it on a new layer. Simply set the layer's Speed to your next lowest speed
setting and make sure Min and Max powers are what you set for the very first square.

LightBurn "remembers" the Power Scale for each square from the original row. So you only need
to set the layer speed and power.

Note that this will give you a test matrix that has power along X and speed along Y.

A note for DSP users:

If you have a Ruida or other DSP controller, Power Scale ramps the power between Min Power
and Max Power, and Min Power must be high enough for your tube to fire. Every tube has a
slightly different firing point, but for the sake of this example, let's call it 10%. If your Min Power
setting is 10%, and your Max Power setting is 80%, the Power Scale parameter is like a slider
between those two numbers: a scale of 0% in this case means "use Min Power" (10%), a scale of
50% is "half way from Min Power to Max Power" (half way between 10 and 80 is 45), and a scale
of 100% means "use Max Power", or 80% in this case. This makes it a little bit trickier when
setting up a grid for testing, but it's still quite useful.
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Creating Vectors in LightBurn  
LightBurn has a powerful set of tools for creating basic shapes directly in the workspace. These
can be accessed via the Tools menu or via the Tools toolbar located along the left side of the
default window.

Basic shape creation  

Pen Tool  

Video Tutorial #2: Pen Tool

Lets you draw lines.
Lines will automatically snap to existing vertices of objects as well as center points on
shapes.
Hold Ctrl ( on Mac) to bypass snapping behavior.

Rectangle and Ellipse Tools   

Video Tutorial #2: Rectangle and Ellipse

Quickly draw rectangle or ellipse.
Holding Shift locks the aspect to create squares or circles.
Holding Ctrl ( on Mac) creates them from the center out.

Creating rounded corners on rectangles  

You can create rounded corners on rectangles by selecting the shape and going to the Shape
Properties tool window. In this window you can edit the base path properties including Width,
Height and Corner Radius.

Polygon Tool  

The Polygon tool allows you to draw an N-sided polygon. Select the polygon tool and draw a
shape on the screen. Then select the shape and go into the Shape Properties dialog box. You will
see a Sides option below Width and Height to allow you to set the number of sides you want.

 

Node Editing Tool  
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Video Tutorial #2: Node Editing

Allows you to move the vertices of a selected shape.
Pressing the S key when hovering over a node will convert it to a smooth node, and if
required, creates tangent handles that can be manipulated from it.
Pressing S while hovering over a line will convert the line to a smooth curve, with tangent
handles, but leaves the shape of the original line intact.
Pressing L while hovering over a smooth curve will convert it back to a straight line.
Pressing C while hovering over a node will convert it to a corner, allowing the two handles to
be manipulated independently of each other.
Pressing D when hovering over a node will delete it and connect the lines on either side
together.
Pressing D when hovering over a line will delete it and open or split the shape.
Pressing I when hovering over a line or curve will insert a new node at that point along the
line
Pressing B when hovering over a point will break the curve at that point

Snapping  

Note that in all of the above tools, when creating a new shape, you will occasionally see the
cursor change if you hover over a point on an existing shape. This means LightBurn is going to
snap what you're about to make to that point. You can bypass this behavior by pressing the Ctrl
key (Command on Mac). LightBurn will snap to object centers, end points of lines or curves, or
center point of lines or curves, in addition to just snapping to the grid.

 

Text Tool  

Video Tutorial #2: Text Tool

Create text on the screen, or edit existing text by clicking within it.
Quickly change font and size.
Alignment (Left, Right, Top, Bottom, Center).

More information about creating text in LightBurn can be found here.

Offset Tool  

Video Tutorial #2: Offset Tool

https://www.youtube.com/watch?v=uzFsrUwONbw#t=9m15s
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Create an offset line around the selected objects.
Can increase or decrease the offset distance, either outward, inward or both.
Corner style can be set to round, bevel or corner
Options to delete the original, select the resulting objects and optimize/simplify results
Resulting shape is grouped automatically.
You can ungroup and remove unwanted outline portions .
Resulting shape can be auto-converted to splines.
Can auto-delete the source shape(s) if desired.
Pressing the Offset button with the Ctrl key pressed ( on Mac) executes with the last used
options.
Offsets can now be applied to open vectors, as well as closed shapes.

Boolean Operations  

Vector shapes can be modified using the Boolean Tools

Text Auto-weld  

When using script fonts, LightBurn will auto-weld the letters together. This can be disabled, as
certain fonts misbehave when welded. If you notice anything disappear, try turning off the
welding for that text object.
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Importing External Vectors  
LightBurn supports the following external vector file formats

.ai - Adobe Illustrator

.pdf - Adobe Portable Document Format

.dxf - Drawing Exchange Format

.svg - Scalable Vector Graphics

.hpgl / .plt - Plotter vector graphics

These files can be added either by using the File -> Import option in the main menu, clicking the

Import button  on the toolbar, or dragging the file into the work area.

When using drag & drop to import a file, the content of the file is placed exactly at the mouse
location when you release the button. If using the menu item or import button, the file is placed
in the center of the work area. If you want the file to drop to the same location it exists in the
source document, hold the Shift key when you import.

Please note that each of these file formats is incredibly complex, and it's not feasible to support
every option available in the packages used to create them.

Also note that embedded images are currently only supported in SVG files, though support is in
progress for AI / PDF formats. Text objects are also not imported, and will need to be converted
to paths / curves in the source art package for importing into LightBurn.

Importing Files with Layers and Colors  

When importing, LightBurn assigns a different cut layer to each unique color it encounters in the
source file, either fill or stroke. If a shape is assigned both fill and stroke colors, the stroke color
takes precedence.

LightBurn will attempt to match colors being imported to its internal palette. Any matching colors
will be assigned first, and any unmatched colors will be assigned in order to the remaining colors
in the palette.
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Boolean Operations  

Weld, Union, Subtract and Intersection for vectors  

On the left hand side of the tool bar there are 4 icons that allow you to combine (Weld) vector
shapes, add (Union A+B) vector shapes, subtract (Boolean Subtract A-B) vector shapes and
Intersect (Boolean A and B) vector shapes. Each icon is a visual representation of what it will do to
the selected shapes.

Weld  

Clicking on the Weld icon will join all the selected shapes into a single entity that is the outline of
all the selected shapes.

Boolean Union  

Union is similar to weld, but works with 2 selected objects only. However these selected objects
can actually be grouped items, not just a single vector shape.

Boolean Subtract  

Boolean subtract will remove the area that the second selected shape overlaps the first shape by.
The order in which you select shapes will determine the outcome. This tool also works with
grouped items.

Boolean Intersection  

This will create a shape from 2 selected shapes that has an outline defined by only the areas in
which the shapes overlap. This tool also works with grouped items.

Quick Video Walkthrough of the Boolean
Operations

 

Click for a Boolean demonstration video

The above video describes in more detail how the various Boolean operations differ, and why
welding text to a circle should be done with a Boolean Union instead.
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Engraving Raster Images  
Supported Image Files

Engraving Configuration

LightBurn has the ability to engrave raster images (photo engrave) without additional effort.

Supported image files  

bmp (Bitmap)
jpg and jpeg (Joint Photographic Exports Group)
png (Portable Network Graphics)
gif (Graphics Interchange Format)
tga (Truevision)

Engraving Configuration  

Double click on the cut layer in the Cuts tool window to launch the Cut Settings Editor window.
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Speed  

See Speed under Operations

Max Power  

The maximum laser power for pure black. Setting this to a lower value will decrease the power of
the laser when engraving absolute black.

Min Power  

The minimum power of the laser for pure white. Increasing this value beyond your lasers firing
threshold will allow the laser to fire for absolute white.

TODO: Reword the next section

A note on Min/Max power: This scale affects the entire range from white to black. If your image
does not have absolute black or absolute white then it will not ever fire at the min/max settings.

Mode  

Disabled for raster images
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Bi-Directional Scanning  

See Bi-Directional Scanning under Operations

Negative Image  

This will invert your image during engraving. Light becomes dark, dark becomes light. This is
useful for engraving slate or glass, where burned areas become lighter.

Overscanning  

See Overscanning under Operations

Line Interval  

See Line Interval under Operations

Scan Angle  

See Scan Angle under Operations

DPI  

Controls the pixel density of the output - this is simply another way of representing line interval
that is more intuitive for some. DPI (dots per inch) is just 25.4 / interval.

Image Mode  

Changing the image mode will change the algorithm used to prepare the image for engraving.

Threshold: a simple on / off switch if the image is dark / bright at a given location. This
should only be used for images that are two-color black/white to begin with, like an image
you dithered outside of LightBurn. Don't use this mode for grayscale or color images.
Ordered: Also called ordered dithering, this is a step above threshold for grayscale images,
and uses densely packed on/off dots to approximate shading, using an ordered/regular grid
pattern. This is ok for general use, but works best for images with large areas of solid fill,
where diffusion dithering can cause unwanted artifacts (see below).
Dithered: Also called error diffusion dithering, this is the best choice for smoothly shaded
images, like photos. This also approximates shading with simple dots, but does so without
evident patterning, and tends to produce more subtle shading.

Here's how they look. The original image (Madrid truck):
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Threshold:

Ordered:



Dithered:

 

Limitations with dithering  

Dithering is attempting to use 2 colors (black and white) to approximate continuous shading, and
it has its limits. Diffusion dithering works by remembering how "off" a given pixel was, and
smearing (diffusing) that difference around over neighboring pixels. When those neighbors are
computed, that error amount is factored in. If you have an image with large areas of solid black
or white, there's nowhere for this error amount to get absorbed (black and white are always
exact), so it keeps pushing it further and further, and you sometimes end up with strange lines or

af://n1697


tendrils in your picture. Ordered dithering does not have this issue, so it works better for "solid
filled" images, like cartoons or logos.

The LightBurn icon is shown below using in both diffusion and ordered dithering.

Number of Passes  

How many times to repeat the entire engraving process.

Pass Through  

This option tells LightBurn not to perform any resizing or resampling of the image, which it does
by default. Turning on pass-through is useful if you have an image that is dithered outside of
LightBurn, using software like PhotoShop, PaintShop, Photograv or One-Touch photo. When pass-
through is on, LightBurn will send each line of pixels from the image directly to the laser using
Threshold mode. You can uniformly resize the image, but you cannot do non-uniform resizing
(different scaling applied to width & height) and you cannot rotate the image, as both of these
require resampling to process correctly.
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Tracing Images  
LightBurn has a feature that will trace the outline of a bitmap image and convert it to a vector
graphic. This works best for content that has very clear edges, like a silhouette or a cartoon. It
does not work very well for photographs, though with some cleanup those may be usable as well.

To start, import an image object into LightBurn, select it, then choose Tools -> Trace Image from
the menu (or press Alt-T)

You'll be presented with the Trace Image dialog, with your image showing in the window, like this:
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In the image above, the purple lines are the vectors that LightBurn has produced from the image
being traced. If you want to be able to see them more clearly, click the "Fade Image" button, and
the image will dim. You can also zoom and pan using the same controls as the preview window
(mouse wheel to zoom, and click-drag the view with either left or middle mouse).

Controls:  
Ignore less than  

This setting tells the vectorizer to ignore anything smaller than this many pixels in area. If you are
trying to vectorize a noisy image, increasing this may help.

Smoothness  

Bitmap images are made of pixels, and pixels are rectangles. Image tracing tries to infer shapes
from these arrangements of rectangles, and has to smooth out the results or everything would
just look like stairs. Part of the process is trying to recover smooth shapes from jagged lines, and
this number controls how aggressive the smoothing is. A value of 1.333 is the maximum, and will
make almost everything into curves. A value of 0.0 will produce all straight lines. The difference is
shown below:

Notice in the left image, with a Smoothness of zero, the area highlighted in red is made of several
line segments, whereas the same area in the right image is a continuous curve. The area shown
in blue is also sharp in the left image, but with the Smoothness value set to maximum, the image
at right shows how even sharp corners become smoothed, and this is rarely desired. The default
value of 1.0 is a good mix between producing smooth curves while still maintaining sharp
corners.

Threshold  

The Threshold value controls the brightness value used as the cutoff between "light" and "dark"
pixels. In images with continuous shading, or images that are very light or dark, you may need to
adjust this value to get the best result.

Optimize  
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After generating lines and curves, the image trace feature will attempt to merge similar lines and
curves together to reduce the node count of the result. The Optimize parameter controls how
aggressive this is. 0 means no merging. The default of 0.2 is a nice balance between accuracy of
the result and node count.

Fade Image  

Dims the image to make it easier to see the resulting vector shapes

Show Points  

Enables the display of the points (nodes) of the resulting vector trace. Enabling this is useful
when you are tuning the Optimize parameter to see the resulting points.
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Manipulating Drawings  
Scaling and Resizing  

Understanding Scale vs Size  

The tool bar and the drag handles will alter the scale of an object. The Shape Properties will alter
the size of the object. This is an important concept that is not always easy to understand.

Take the following example

A diamond best expresses this concept as the actual size of the image in the Shape Properties
differs from the width and height shown in the toolbar at the top. In this case, the diamond
measures 50x50 however the measurement of the overall footprint of the diamond is actually
just over 70x70 if you measure from corner to corner. If you scale this shape using the toolbar or
the drag handles, it will appear to resize the diamond but in fact it's just squashing it or stretching
it out to fill the dimensions you specify. The original diamond is still 50x50.

This is especially important for corner radius. The only way to change the size of your drawing
and maintain the proportionality of the corner radius is to change it in the Shape Properties. If
you scale the image the corners will stretch or squash just like the rest of the shape to fit your set
scale dimensions.

 

Scaling with Drag Handles  

When you select a drawing a set of 8 drag handles will appear around the perimeter. Clicking and
dragging with these handles will scale your drawing freehand. When doing this you can also note
the width and height in the toolbar updating accordingly.
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Scaling with Toolbar  

When you select a drawing, you can accurately scale using the width and height using the toolbar
values.

Resizing with Shape Properties  

Using the Shape Properties dialog will resize the shape (note this is different from scaling). Using
this will maintain corner radius proportions.

Rotation  

With Toolbar  

You can rotate a drawing by selecting the drawing and providing an exact degree of rotation in
the toolbar

With Rotation Handles  

You can also rotate by grabbing the rotation drag handle and rotating freehand

Corner Radius  

Shape Properties  

You can easily set a corner radius in the Shape Properties dialog box. This will set the radius
relative to the width and height in Shape Properties. If you try to scale the image with the toolbar
or drag handles, the corners will skew accordingly. However resizing with the Shape Properties
width and height will maintain the radius as set.
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Placement  

Toolbar  

You can quickly and accurately place your drawing to specific points in your working area
including Page Center, Upper Left or Right, Lower Left or Right or Laser Position. After selecting
your drawing click on the placement toolbar icon and select your location.
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Troubleshooting  
Machine Connectivity

Workspace / UI

GRBL Errors

Machine Connectivity  

Reconnecting to a device  

If you need to reset your device connection, from the Laser toolbox, right-click the Devices button.
LightBurn does a full disconnect / reconnect cycle when you right-click the Devices button, or
when you click Ok from the devices menu.

Workspace / UI Issues  

Lost toolbar  

A common question is "Where did my Toolbar or Tool Window go?"

A right click on any open area of a toolbar will bring up the options to turn on or off any toolbar
or tool window. Click on the missing item to return it to your workspace.

GRBL Errors and what they mean  
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Error Description

error:1 G-code words consist of a letter and a value. Letter was not found.

error:2 Numeric value format is not valid or missing an expected value.

error:3 Grbl '$' system command was not recognized or supported.

error:4 Negative value received for an expected positive value.

error:5 Homing cycle is not enabled via settings.

error:6 Minimum step pulse time must be greater than 3usec

error:7 EEPROM read failed. Reset and restored to default values.

error:8
Grbl '$' command cannot be used unless Grbl is IDLE. Ensures smooth
operation during a job.

error:9 G-code locked out during alarm or jog state.

error:10 Soft limits cannot be enabled without homing also enabled.

error:11 Max characters per line exceeded. Line was not processed and executed.

error:12
(Compile Option) Grbl '$' setting value exceeds the maximum step rate
supported.

error:13 Safety door detected as opened and door state initiated.

error:14 (Grbl-Mega Only) Build info or startup line exceeded EEPROM line length limit.

error:15 Jog target exceeds machine travel. Command ignored.

error:16 Jog command with no '=' or contains prohibited g-code.

error:20 Unsupported or invalid g-code command found in block.

error:21 More than one g-code command from same modal group found in block.

error:22 Feed rate has not yet been set or is undefined.

error:23 G-code command in block requires an integer value.

error:24
Two G-code commands that both require the use of the XYZ axis words were
detected in the block.

error:25 A G-code word was repeated in the block.

error:26
A G-code command implicitly or explicitly requires XYZ axis words in the block,
but none were detected.

error:27 N line number value is not within the valid range of 1 - 9,999,999.

error:28
A G-code command was sent, but is missing some required P or L value words
in the line.

error:29
Grbl supports six work coordinate systems G54-G59. G59.1, G59.2, and G59.3
are not supported.



Error Description

error:30
The G53 G-code command requires either a G0 seek or G1 feed motion mode
to be active. A different motion was active.

error:31 There are unused axis words in the block and G80 motion mode cancel is active.

error:32
A G2 or G3 arc was commanded but there are no XYZ axis words in the selected
plane to trace the arc.

error:33
The motion command has an invalid target. G2, G3, and G38.2 generates this
error, if the arc is impossible to generate or if the probe target is the current
position.

error:34
A G2 or G3 arc, traced with the radius definition, had a mathematical error
when computing the arc geometry. Try either breaking up the arc into semi-
circles or quadrants, or redefine them with the arc offset definition.

error:35
A G2 or G3 arc, traced with the offset definition, is missing the IJK offset word in
the selected plane to trace the arc.

error:36
There are unused, leftover G-code words that aren't used by any command in
the block.

error:37
The G43.1 dynamic tool length offset command cannot apply an offset to an
axis other than its configured axis. T he Grbl default axis is the Z-axis.

error:38 An invalid tool number sent to the parser

Alarm Description

ALARM:1
Hard limit triggered. Machine position is likely lost due to sudden and
immediate halt. Re-homing is highly recommended.

ALARM:2
G-code motion target exceeds machine travel. Machine position safely
retained. Alarm may be unlocked.

ALARM:3
Reset while in motion. Grbl cannot guarantee position. Lost steps are likely. Re-
homing is highly recommended.

ALARM:4
Probe fail. The probe is not in the expected initial state before starting probe
cycle, where G38.2 and G38.3 is not triggered and G38.4 and G38.5 is triggered.

ALARM:5
Probe fail. Probe did not contact the workpiece within the programmed travel
for G38.2 and G38.4.

ALARM:6 Homing fail. Reset during active homing cycle.

ALARM:7 Homing fail. Safety door was opened during active homing cycle.

ALARM:8
Homing fail. Cycle failed to clear limit switch when pulling off. Try increasing
pull-off setting or check wiring.

ALARM:9
Homing fail. Could not find limit switch within search distance. Defined as 1.5 *
max_travel on search and 5 * pulloff on locate phases.



Message Description

Hold:0 Hold complete. Ready to resume.

Hold:1 Hold in-progress. Reset will throw an alarm.

Door:0 Door closed. Ready to resume.

Door:1 Machine stopped. Door still ajar. Can't resume until closed.

Door:2 Door opened. Hold (or parking retract) in-progress. Reset will throw an alarm.

Door:3
Door closed and resuming. Restoring from park, if applicable. Reset will throw
an alarm.
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Video Links  

LightBurn Academy  

These are a series of videos to guide users in using LightBurn. Videos will be added on a regular
basis.

1. Lesson 1: First Time Users
2. Lesson 2: User Interface
3. Lesson 3: Cut Settings
4. Lesson 4: Boolean Operations

LightBurn Progress Videos  

This series of videos documents the progress of LightBurn. Many of the features have been
superseded by improved methods but this still gives a good introduction to the software.
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Requesting Help for LightBurn  
When asking for support for LightBurn via any social media outlets or email, please keep the
following tips in mind for the fastest and most helpful answers.

Please speak in complete sentences with proper spelling, grammar and punctuation.
Fragments and run-ons are not pleasant nor easy to read. We understand that many of our
users are not native English speakers, and are more than accommodating, but some effort
should be made from everyone please.
Explain what is happening. A picture tells a thousand words, but we need at least a few
words explaining the context: what did you do, what the issue is, what the machine is or is
not doing, and so on. Also please include pictures of the full screen, and then use words to
tell us where to focus our attention, as described above.

tl;dr: pictures and punctuation, thank you.

Other important details that may help diagnose your problem. Are you running the latest build or
what version are you experiencing this issue on? When did the issue begin/ how long have you
been experiencing it? What operating system are you using?

Spell it out for us: "I did ___, I expected ___ to happen, but instead did / did not happen.

Just a few steps to make the lives of the people helping easier, and to improve your odds of
getting help.

Thank you.
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Common Grbl setups  
If you have a GCode-based system, like a Shapeoko, Eleksmaker, X-Carve, or Acro system, you
might need to make some simple changes to get the most from LightBurn.

Short version:  

You might need to adjust your spindle max RPM value ($30) to match the LightBurn default
(1000) or vice versa. The value in LightBurn is called "S-Value Max", in the Device Settings.
You might need to enable "Laser Mode" if you have GRBL 1.1f or later ($32=1).
If your machine uses negative workspace coordinates you'll need to apply a workspace
offset (G10 L2 P1 xx yy) and set your machine status reporting to be relative to the
workspace origin, not the machine origin ($10=0).

 

Grbl Flavors  

Grbl firmware was originally designed for CNC machines and 3D printers, with laser support
added more recently. It is highly configurable, and this is both a blessing and a curse. The
"standard" way a CNC machine is configured is somewhat different than the way laser machines
often are. Luckily this is easy to change, and easy to switch from one to the other.

The latest versions of Grbl (1.1f and onward) support a feature called variable power mode for
lasers. This allows the laser power to be adjusted up and down as the machine speeds up and
slows down, making for very consistent cutting and marking. Older versions of Grbl do not have
this feature, and simply run the laser at a constant power output for the duration of a cut. Since
the machine needs to slow down to take sharp corners, this means corners get over-burnt, while
long straight lines end up lighter.

This also has the benefit that when the laser comes to a complete stop, the beam turns off (zero
speed equals zero power), meaning that pausing a job automatically turns off the laser. This is
not always true with other versions of Grbl.

If you aren't already running Grbl 1.1f on your controller, we highly recommend it for laser use. If
this isn't an option, that's ok, but your results won't be as good, and pausing the laser runs the
risk of leaving the beam on and ruining the job.

 

Shapeoko  

Shapeoko machines typically use Grbl 1.1f, but are configured for negative workspace
coordinates, which LightBurn doesn't support. This is an easy thing to work around though, using
a workspace offset.

We'll use a Shapeoko XXL as our example setup. This machine has an 812mm x 812mm working
area, and the origin is set to the rear-right, with negative numbers going down and to the left
(onto our workspace). We're going to leave the direction alone, but change the origin position by
using this command in the LightBurn Console window:

G10 L2 P1 X-812 Y-812
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That command says "set an offset" (G10 L2) in the first coordinate system (P1) of X -812 and Y
-812. (If your machine is a different size, use your width and height values in mm instead of the
812's shown here, and remember the minus signs - those are important)

This shifts the origin point of the machine left and forward by the size of the workspace. Then
you tell LightBurn that the origin is at the front-left of the machine, instead of the rear-right, and
you're done.

When you want to go back to using your machine for CNC use, clear the offset with:

G10 L2 P1 X0 Y0

It is simple to set these up as macro buttons in the LightBurn console window. Enter the first
command into a macro and call it "Use Laser", and enter the second command into a different
macro and call it "Use CNC". When you want to use your laser, click the "User Laser" macro
button, and when you're done and want to switch back to CNC, click the "Use CNC" button.

 

X-Carve  

X-Carve machines sold prior to January 2018 generally run an older flavor of Grbl (1.0c) which
does not support the variable power (M4) command, meaning you'll need to use the Grbl-M3
device in LightBurn. Machines sold after that date use Grbl 1.1f, and will work with the standard
Grbl device in LightBurn if the following settings commands are entered in the console:

32=1

These two lines set the spindle max value ($30) to match LightBurn and Grbl's default setting
(1000), and to enable laser mode ($32).

 

Other machines  

If you aren't sure how to configure your machine, there are some simple steps to take that can
help. First, figure out which firmware you're running. In LightBurn, when you first connect to the
machine, the console window will usually show a 'hello' message from the controller. For
Smoothieware boards it's just "Smoothie". For Grbl, it will be "Grbl 1.1f [$ for help]" or similar -
this tells you it's Grbl, and which version. Machines using Grbl 1.1f or later will support the M4
variable power command, and just use the "Grbl" driver in LightBurn. Grbl 1.1e or older (Grbl 1.0,
Grbl 0.9, etc) must use the Grbl-M3 device in LightBurn.

With the driver identified, it's time to find the machine origin. First, home the machine by
pressing the Home button ( ) on the Move window.

In the console window, type

G0 X0 Y0

then hit enter. Your machine will head toward its origin position. This isn't always the same as
where the home position is. Usually the home position is in one of the corners. Most often it will
be the rear-right, or front-left of the machine. In some cases, it might be the center of the work
area. If your machine does this, skip ahead to 'Center Origin Machines' below.

After it stops moving, type

G0 X10 Y10
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then hit enter. If your machine moves 10mm into the work area on both axis that's good - it
means your machine uses positive workspace coordinates. You simply set the origin in LightBurn
to match the machine origin discovered above. If your machine bumped the rails, it uses negative
coordinates.

Negative Coordinate Machines  

If your machine uses negative coordinate space, we need to offset the origin.

LightBurn wants positive workspace numbers, like this:

This image shows the origin at the front-left, with positive X values moving to the right, and
positive Y values heading to the rear of the machine.

A negative workspace system looks like this:

In this image, the origin is at the rear-right of the machine. The X and Y directions are the same as
before, but now, to move into the work area, you would need to use negative numbers. Instead,
we're going to set up a work offset.
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You'll need to know the total distance your machine can travel in both axis. For a Shapeoko XXL,
for example, it's 812mm in X and Y. For a 500x500 X-Carve, it's 250mm in X and Y. By applying a
workspace offset that is the size of your machine area, we can shift the offset to the opposite
corner, like this:

Enter the following command:

G10 L2 P1 X-250 Y-250

in the console, and hit enter. Note that the '250' above should be replaced with the total travel
width and height of your machine. If your machine had a 600mm width and 400mm height, you
would use:

G10 L2 P1 X-600 Y-400

This command offsets the origin by the given amounts. If the origin used to be in the rear-right of
the machine, and you offset it in the negative direction by the width and height of the work area,
you've moved the origin to the front-left.

If you enable a workspace offset, you will also need to make GRBL report its location relative to
this shifted origin, instead of in "machine space" by setting $10=0. Some systems, like Easel or
Carbide Motion, may need a different value, so it is good to remember the existing setting.

 

Center Origin Machines  

Some systems have their origin in the center of the workspace. After homing your machine, enter
this command in the console and hit enter:

G0 X0 Y0

That command says "rapid move to coordinate 0,0"

If your machine does this, you still need to move the origin just like in the "Negative Coordinate
Machines" above, but only by half the size of your workspace. Follow the directions for a negative
coordinate space machine, but divide your workspace numbers in half before issuing the GCode
offset command.
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Frequently Asked Questions  

Q: I just paid, how long until my license arrives?  

A: Sometimes as long as 12 hours. The license process is manual, and we occasionally require
sleep.

Q: How is the license key delivered?  

A: It is sent to the email address you provided when you paid, or your PayPal email address, if
you purchased with PayPal.

Q: If I update, do I need to re-apply my license, or lose my
trial?

 

A: No, the license system stores a digital fingerprint independent of the software. You are free to
update as long as either your trial or license have not expired. When your license expires, the
version you have will continue to work, but you will not be able to run any version created after
your license expired. You can renew to gain access to updates for another year. We’re hoping to
make the renewal fee $25.

Q: Does LightBurn work with the stock K40 board?  

A: No. Please get a real controller that allows control of power through software. Even a lowly
Arduino running Grbl can do this. We recommend a Cohesion3D Mini (Laser Upgrade Bundle)
though – it’s a drop-in replacement that takes about 5 to 10 minutes to install.

Q: Does LightBurn work with (strong LED flashlight they
called a laser) that I bought from HappySunshine888 on
EBay?

 

A: It might. You’ll need to find out what kind of controller it has, and if it uses Grbl, Smoothieware,
or something proprietary. If it’s one of the first two, it will probably work, though you may have to
update the firmware or change some of the settings. We can’t tell you how to do this, but Google
or another forum member probably can.

Q: Does LightBurn support Epilog, Trotec, Universal, Full
Spectrum, or GCC Lasers?

 

A: Sorry, no. We’re a very small company, and don’t have the financial resources to buy one of
these high priced wonders in the hope that we can reverse engineer the control protocols, and
they don’t return our calls. If enough of their customers poke them, perhaps that will change. (If
you have one of these and are technical enough to help with traffic captures, we’d love to talk to
you)

Q: Do you have a list of supported features somewhere?  
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A: Sort of – our documentation is available online if you’re one of those rare unicorns who reads
such things. Writing a real list of supported features would take a long time, and would constantly
be out of date – we update very often. (https://github.com/LightBurnSoftware/Documentation/bl
ob/master/README.md)

Q: What does “ALARM 2” mean?  

A: It means your GRBL controller tried to go out of bounds. (http://grblminicnc.blogspot.com/201
7/04/grbl-error-list.html)

Q: When I hit the home button it just says “error: 5” – why?  

A: You don’t have homing enabled on your GRBL controller. (http://grblminicnc.blogspot.com/201
7/04/grbl-error-list.html)

Q: I hit the thing but it didn’t do the thing.  

A: This is not a question, and does not contain any useful information whatsoever. Please try to
be descriptive when you post questions – we’re here to help, but we’re not clairvoyant.

Q: I have suggestions – should I post them here?  

A: You should post them to our suggestion site. Other people can vote on suggestions, we read it
regularly, and it helps us prioritize feature development. It’s here: https://lightburn.fider.io/

Q: I imported an SVG file but only get Image options for
Mode

 

A: SVG files do not automatically imply vector drawings. It is possible to have a bitmap/raster
image embedded in an SVG file and LightBurn will treat it as any other bitmap and give you the
Image engraving options. If you are trying to create vector tracing, you will need to use the Trace
Image (ALT+T or Tools -> Trace Image) function in LightBurn or another application to create line
art of the image.

Q: My X/Y axis moves the wrong way when I Start  

A: Change the origin from back to front or vice versa. The most common mistake people make is
thinking that the homing position and zero position are the same. They often aren’t. On a K40, for
example, the limit switches for homing are in the rear left, but X0 Y0 is front left.
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Entering your License Key  
When you first start LightBurn you will be prompted to enter your license key or start your trial
version. If you do not have a license key you can click the Start your Free Trial button to being your
30-day unrestricted trial of the software.

If you have your license key, enter it in the License Key box and click the Activate License button.

Once you enter and activate a valid license key you will be prompted to restart LightBurn for the
license to take affect.

Checking your license status  

You can check your license status at any time or enter a new license key by clicking Help > License
Activation and Trial
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Scanning Offset Adjustment  
Modern lasers are capable of moving very fast, and with remarkable precision, however firing the
beam still takes time. Some power supplies and tubes may respond in less than a millisecond,
but many take longer.

At 100 mm/second, 254 dots per inch means your dots are 0.1mm in length, fitting 1000 of them
in 100mm. At 100 mm/sec, if your power supply and tube take 1 millisecond to fire, your
engraving will be offset by a full dot width.

At 500 mm/second, that 1 millisecond delay means you'll be off by 5 dots, or 1/2 a millimeter. Still
not very much, but visible. Many power supplies and tubes will take even longer to fire.

The result often looks like ghosted edges. The image below is a 20mm square at 1000 mm/sec,
with a 1ms delay, resulting in a full mm of skew between scans:

 

LightBurn has a setting to counter this, called Scanning Offset Adjustment, in the Device Settings:
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To use this feature, you need to measure the response of your machine at a couple of different
speeds. Create a small rectangle in LightBurn, 50mm wide and 10mm high, set it to scan, and set
the interval to 0.5mm. If you are on a GCode based device, enable overscan, and set it to 5% or
greater to be sure the machine is not slowing down before reaching the ends. (Ruida devices
overscan automatically). Note that in the image below I have power set to 0 - Don't do this. You
will need to set the power high enough to mark your material.



Run this rectangle at multiple speeds, like 100mm/sec, 200mm/sec, 300mm/sec, and so on.
Depending on your hardware you may not even need to use these settings, however here is
example output from a machine that does:



To compensate for this, measure the distance between the ends of the lines at each speed, and
enter the speed and distance values into the scanning offset adjustment table. LightBurn will use
this information to compute the correct adjustments for other speeds as well. A minimum of two
measurements are needed for it to work. Note you will need enter half the measured value - The
software moves each line by the amount you specify, so each pair of lines only needs to move
half the distance.

There is an excellent tutorial online at Cartonus.com here: http://cartonus.com/how-to-improve-e
ngraving-quality-of-laser-machine/

You may need to do this multiple times, making minor adjustments to get clean results at each
speed. After entering the measurements for the above speeds, the resulting corrected output
looks like this:

http://cartonus.com/how-to-improve-engraving-quality-of-laser-machine/


Line Wobble  
A different, but equally common problem, is line wobble, often caused by too high an
acceleration setting. When doing the test cuts above, you may notice lines that look like this:

If so, your machine is moving too quickly between the rows, and you're seeing physical "bounce"
in the gantry because of it. Lowering the acceleration setting for your Y axis can correct this.
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Variable Text in LightBurn  

Variable text is a feature that allows you to use special codes in your text entries that will be
substituted for something else when you send the data to the laser (or the preview). Variable text
can be used for:

Date or time stamps
Serial numbers
Displaying cut settings
Merging a CSV file into your designs

In all of these cases, the text in LightBurn is set to one of the dynamic text modes, and the text
entered is used to tell LightBurn what you want it to display. You select the text mode like this:

With the mode selected, you enter one of the special codes for that mode, and when you
preview, save, or send the file to the laser, LightBurn will replace the text with the desired output.

The different formatting codes are listed here: Variable Text Formats

 

Variable Text Manager  

If using serial numbers or a CSV file, you have additional controls, available in the Variable Text
window in LightBurn, shown below:

The values shown are:

Current: The current serial number, or row from the CSV file, that will be displayed.

Start: The first serial number you want to use, or the first row in the CSV file to be used.

End: The last serial number to use, or the last row in the CSV file to use.

Advance by: Imagine you are creating a series of numbered labels. Rather than cutting each one
separately, you would most likely want to do several at once on a page. The "Advance by" value
tells LightBurn how many entries to advance ahead when you click the Next or Previous buttons,
or when it automatically advances to the next page for you.

 

The buttons on the right are for:
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Previous: Go to the previous page of values (decrements the Current entry by the 'Advance by'
amount)

Next: Go to the next page of values (increments the Current entry by the 'Advance by' amount)

Test: Displays the text that will be output, for as long as the button is pressed.

Reset: Resets the Current value to the Start value

Auto-Advance: When this switch is enabled, each time you press one of the 'Start', 'Send' or
'Save as..' buttons in the Laser window, LightBurn will automatically advance the Current value by
the 'Advance by' amount. If you are running a large batch of parts, names, serial numbers, etc,
each time you send a job to the laser the software will advance to the next batch.

 

There is a property on text objects called Offset which controls is added to the current variable
text index when evaluating the text object. This allows you to have text objects on your design
that display different serial numbers, or different rows from the CSV file.

If you created a design with 4 name tag labels on the page, you would set the Variable Offset
value for each of the four labels to 0, 1, 2, and 3, and tell the Variable Text manager to advance by
4 with each run.



Output Expression

the day as number without a leading zero (1 to 31) d

the day as number with a leading zero (01 to 31) dd

the abbreviated localized day name (e.g. 'Mon' to 'Sun'). Uses the system
locale to localize the name.

ddd

the long localized day name (e.g. 'Monday' to 'Sunday'). Uses the system
locale to localize the name.

dddd

the month as number without a leading zero (1-12) M

the month as number with a leading zero (01-12) MM

the abbreviated localized month name (e.g. 'Jan' to 'Dec'). Uses the system
locale to localize the name.

MMM

the long localized month name (e.g. 'January' to 'December'). Uses the
system locale to localize the name.

MMMM

the year as two digit number (00-99) yy

the year as four digit number yyyy

Return to main page

These are the different formatting codes used for Variable Text in LightBurn.

Date / Time text format  

When using the Date/Time mode for text, the system will automatically substitute special
combinations of characters with values for the current local date and time.

For example, if your text field is "d/MM/yyyy" the system would replace it with "15/6/2019". The
values you can use for substitution are listed below.

These expressions may be used for the date:

These expressions may be used for the time:
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Expression Output

h the hour without a leading zero (0 to 23 or 1 to 12 if AM/PM display)

hh the hour with a leading zero (00 to 23 or 01 to 12 if AM/PM display)

H the hour without a leading zero (0 to 23, even with AM/PM display)

HH the hour with a leading zero (00 to 23, even with AM/PM display)

m the minute without a leading zero (0 to 59)

mm the minute with a leading zero (00 to 59)

s the whole second without a leading zero (0 to 59)

ss the whole second with a leading zero where applicable (00 to 59)

z
the fractional part of the second, to go after a decimal point, without trailing
zeroes (0 to 999). Thus " s.z " reports the seconds to full available
(millisecond) precision without trailing zeroes.

zzz
the fractional part of the second, to millisecond precision, including trailing
zeroes where applicable (000 to 999).

AP or A use AM/PM display. A/AP will be replaced by either "AM" or "PM".

ap or a use am/pm display. a/ap will be replaced by either "am" or "pm".

t the time zone (for example "CEST")

Input Result

dd.MM.yyyy 21.05.2001

ddd MMMM d yy Tue May 21 01

hh:mm:ss.zzz 14:13:09.120

hh:mm:ss.z 14:13:09.12

h  : m : s ap 2 : 13 : 9 pm

Any sequence of characters enclosed in single quotes will be included verbatim in the output
string (stripped of the quotes), even if it contains formatting characters. Two consecutive single
quotes ('') are replaced by a single quote in the output. All other characters in the input string are
included verbatim in the output string.

Formats without separators (e.g. "ddMM") are supported but must be used with care, as the
resulting strings aren't always reliably readable (e.g. if "dM" produces "212" it could mean either
the 2nd of December or the 21st of February).

Example format strings (for the date & time 21 May 2001 14:13:09.120):

 

Serial number text format  
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Output Expression

The serial number as a decimal value d

The serial number as a hexadecimal value, lower case h

The serial number as a hexadecimal value, upper case H

Tells LightBurn to pad the number with leading zeros 0

Input Output Input Output

d 4 0d 4

dd 34 0dd 34

ddd 234 0ddd 234

dddd 1234 0dddd 1234

ddddd 1234 0ddddd 01234

dddddd 1234 0dddddd 001234

When using the Serial mode for text, the system will automatically substitute certain special
combinations of characters with the current serial number value, and other characters control
how it is formatted.

These expressions may be used for serial numbers:

The number of characters used controls how many digits the system will display. If the serial
number is larger than the number of digits allowed, as many digits as will fit from the end of the
number will be displayed. For example, if your serial number is 1234, the table below shows how
that number would be formatted for each of the displayed formatting inputs:

You cannot mix decimal and hexadecimal formatting in the same text entry, and you cannot split
a serial number with other characters. For example, this string is not valid: ddd-ddd because of
the hyphen between the two groups of format characters.

Like the Date / Time formatting, any text between a pair of single quotes is copied exactly to the
output, and a pair of single quotes together is replaced by one single quote in the output.

 

CSV/Merge text format  

When using the CSV/Merge mode for text, the system will automatically substitute certain special
combinations of characters with entries from the selected row of a CSV file. A CSV file is "Comma
Separated Values" - a very simple text format that uses a line in the file as the row, and commas
to separate columns in the file.

For example:

LightBurn,80,10

Corel,300,20
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Expression Output

s speed, as a number in the current speed units

S speed, including the current units (like mm/sec)

p max power, as a percentage

P max power, including the percent sign

m min power, as a percentage

M min power, including the percent sign

d DPI, as a number, always dots per inch

i interval, in the current distance units

I interval, including the current distance units (like mm)

In a CSV/Merge entry in LightBurn, the text you enter uses the percent sign followed by a number
to look up a column in the current row of the CSV file. For example, using this text with the above
table:

I'm thinking of buying %0 - it costs $%1

Would display:

I'm thinking of buying LightBurn - it costs $80

Columns are numbered starting from 0.

 

Cut Setting text format  

When using the Cut Setting mode for text, the system will automatically substitute certain
characters with values from the cut setting applied to the text.

Like the Date / Time or Serial number formatting, any text between a pair of single quotes is
copied exactly to the output, and a pair of single quotes together is replaced by one single quote
in the output.
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